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Executive Summary 
The Problem 

The concept of automated transportation networks (ATN) has been around since the 1950s. The 
idea of powering an ATN system by collocated solar photovoltaic panels is, however, a recent 
innovation. But there has been a lack of detailed analysis to clearly demonstrate its feasibility, how 
much it would cost, and what its environmental impact would be as compared to more 
conventional transportation alternatives. 

To date, only five rather limited ATN-like systems have been implemented around the world, and 
there is only a proto-ATN industry that city leaders, transportation planners, and consultants can 
turn to for reference. Visualizations of new ATN technology by ATN promoters often lack realism 
and fall short of providing a compelling vision for stakeholders to take seriously. In this way, there 
is a need for more productive visualizations of ATN to help decision makers effectively 
communicate to stakeholders what ATN would look and feel like in order to gain public support 
for such a radically new mode of transportation. 

The Solution 

A solar ATN system connecting the North and South campuses of San José State University was 
designed to both study the feasibility of powering the system by grid-tied solar energy and to 
develop compelling visualizations of what the system would look like and what a user would 
experience when using it.  

The energy feasibility study used data from the SJSU Park & Ride shuttle bus and the microscopic, 
multi-model transit simulation package SUMO along with SUMOPy to quantify the energy 
demand for the proposed network. Custom-written software determined the amount of solar 
photovoltaic panels and battery storage required to have the system operate at or better than zero 
net-metered conditions. PV canopies of eight modules wide for dual-direction guideways and six 
modules wide for single-direction guideways and PV canopies at the stations were found to be 
sufficient to have the proposed network run 24/7 in better than zero net-metered conditions for 
ridership uncertainty of up to 115% based on the Park & Ride data. The resulting energy system 
had a PV rated output of 6.2 MW, a battery system capacity of 9.8 MWh, and an estimated cost 
of $11.4 million USD. Figure ES1 summarizes the results of the analysis. 
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Figure ES1. Results of the energy system analysis. 
 

 
 

The cost of the ATN energy system was comparable to that of the existing SJSU Park & Ride 
service. Moreover, it was more economical to power the ATN with the optimized PV-battery 
energy system than with electricity purchased from the grid. Additionally, the solar-powered ATN 
had CO2 and PM2.5 emissions that were 86% less than those of a purely electric grid-powered 
version and 98% less than those of the SJSU Park & Ride diesel shuttle system.  

A multidisciplinary team of architects, urban planners, engineers, industrial designers, and artists 
developed a realistic instantiation of an ATN system connecting the two campuses with three 
stations: one at the South campus near Spartan Stadium, one at the North campus between the 7th 
St. parking structure and Duncan Hall, and one at the intersection of E. Reed St. and 2nd St. 
Extensive mapping, careful fieldwork, and many design iterations produced a viable guideway 
routing consisting mostly of dual-direction guideway and some single-direction guideway, as 
shown in Figure ES2. The guideway traverses the I-280 highway by going underneath it along 2nd 
St. and 3rd St. The guideway and stations were placed unobtrusively within existing rights-of-way 
along the street, and stations were designed to meld into the built environment with minimal 
disruption to existing structures, as shown in Figure ES3. 
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Figure ES2. Final guideway routing for the study. 

 
 

Figure ES3. North Station and guideway. 

 
 

All stations were designed with one type of modular construction element to achieve economies 
of scale in construction costs and time. Renderings of the central and south stations between the 
North and South campuses are shown in Figure ES4 and ES5. 
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Figure ES4. Mid station between the North and South campuses. 

 
 

Figure ES5. South campus station. 

 
 

In addition to conceptual design and renderings, a comprehensive video was created to clearly and 
compellingly communicate the need for a solar ATN system and what a typical user’s journey on 
the system would be like (Figure ES6). 
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Figure ES6. User journey depicted in a comprehensive video. 

 
 

Recommendations for Next Steps 

This study has shown that grid-tied solar energy coupled with battery storage is up to the task of 
powering a transportation system that could replace the current SJSU Park & Ride operation. Such 
a bold move would serve as the seed for a city-wide solar ATN system, which in turn would be a 
model for the rest of the world as to how urban transportation can be executed in a truly sustainable 
manner.  

It is recommended that SJSU take the following actions:  

• Encourage multiple academic departments within SJSU and across CSU to collaborate and 
advance the development of solar ATN 

• Facilitate IRB approval to conduct stakeholder surveys to obtain feedback on the 
conceptual design of the system linking the North and South campuses 

• Obtain funding from external sources to further academic research and the implementation 
of solar ATN for intercampus transportation 

• Publicize the innovation in solar ATN that has been occurring over the last nine years at 
SJSU (Spartan Superway) 

In short, from the results of this research project, SJSU, the City of San José, and the rest of the 
world have the opportunity to make a significant impact in addressing climate change and 
improving the quality of urban life by developing and implementing solar-powered ATN. 
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1. Introduction 
This chapter will introduce the broader issues that motivate the vision for solar-powered 
transportation and articulate the rationale behind the two research projects that are the main 
subject of this report. 

1.1 Motivation for the Study: Carbon, Crashes, and Crowding 

The world is facing an existential crisis from climate change driven by human activity (Monbiot 
2021; Bradshaw et al. 2021). Figure 1 shows the global surface temperature deviation relative to 
1880-1920 and indicates the effect of human activity on global temperature. The overwhelming 
consensus by those who study climate change and its drivers point to greenhouse gas emissions 
(GHGs), particularly CO2, from the combustion of fossil fuels as the major factor behind the 
observed increasing global temperature.  

Figure 1. Global surface temperature relative to 1880-1920.  
 

 
(Source: Hansen & Sato, 2016). The most recent data finds that 2020 is tied with 2016 as the hottest year 
on record (https://www.giss.nasa.gov/research/news/20210114/). 

 

The increasing global temperature is detrimental to human flourishing and is causing myriad 
serious problems such as (Denchak, 2019): 

• more frequent and/or intense extreme weather events, including heatwaves, hurricanes, 
droughts, and floods, 

• precipitation extremes, making wet regions wetter and dry regions drier, 
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• rising sea levels due to melting glaciers and sea ice and an increase in ocean temperatures 
(warmer water expands, which can contribute to sea-level rise), and 

• altering ecosystems and natural habitats, shifting the geographic ranges, seasonal activities, 
migration patterns, and abundance of land, freshwater, and marine species. 

At present, the largest share (29%) of GHGs in the U.S. comes from the transportation sector, 
amounting to about 1.9 Gt of CO2, as shown in Figure 2. 

Figure 2. Total U.S. Greenhouse Gas Emissions by Economic Sector in 2019.  
 

 
Transportation is the largest contributor. (Source: U.S. Environmental Protection Agency (EPA): 
https://www.epa.gov/ghgemissions/sources-greenhouse-gas-emissions). 

A closer look at the sources of GHGs within the transportation sector is shown in Figure 3, which 
reveals that Light-Duty Vehicles, which consist of passenger cars and light-duty trucks, produce 
the largest share of emissions (59%, according to the most recent [2018] data). Further analysis of 
the Light-Duty Vehicles slice reveals that passenger vehicles account for 70% of emissions 
compared to 30% for light-duty trucks. 

If the goal is to significantly reduce GHGs to fight climate change, according to Pareto’s Principle 
(also known as the ‘80-20’ rule),1 it would be wisest to focus on the major sources of GHGs, the 
largest being emissions from passenger cars. Fortunately, automobile manufacturers have 
recognized this imperative and are rapidly shifting from internal combustion engines to electric 
motors for passenger vehicles and light trucks (Howes 2020).  

  

                                                
1 Economist Vilfredo Pareto (1971) observed that approximately 80% of consequences are due to 20% of 
causes. The observed ratio applies widely and is often used to focus on improving the few things that will 
have the biggest effect on outcomes, i.e., those things with “the biggest bang for the buck”. 
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Figure 3. Share of U.S. transportation sector GHG emissions by source.  
 

 
Light-duty vehicles (passenger cars and light-duty trucks produce the largest share for this sector. Within 
the Light-Duty Vehicles category, passenger cars produce the largest share of GHGs. (Source: Fast Facts 
on Transportation Greenhouse Gas Emissions, 
https://nepis.epa.gov/Exe/ZyPDF.cgi?Dockey=P100ZK4P.pdf). 

 
In theory, electrifying vehicles is a step in the right direction toward reducing GHG emissions if 
the origin of the energy used to charge such vehicles comes from a renewable source. In practice, 
however, the mix of grid energy sources will still have significant amounts of generation coming 
from fossil fuels for the foreseeable future, and thus vehicle electrification will not be a panacea for 
reducing environmental carbon. Figure 4, from the U.S. Energy Information Administration, 
shows the expected mix of energy sources from now until 2050. While electricity from renewable 
sources is expected to double current levels, natural gas will still provide over one-third of U.S. 
electricity in 2050. 

Figure 4. Electricity generation from selected fuels.  

 
(Source: https://www.eia.gov/outlooks/aeo/pdf/AEO_Narrative_2021.pdf). 
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Hence, even if all vehicles were electrified today, most would continue to be charged by a grid 
pumping out GHGs. This problem is compounded by the fact that the mix of energy sources 
across the U.S. is not uniform. A recent study by Yuksel et al. (2016) showed that in some parts 
of the U.S. where the mix of electricity sources come from “dirtier” fossil fuels, it would actually 
be worse, from a GHG perspective, to drive a purely electric vehicle compared to a car with an 
efficient gasoline engine. This paradoxical situation arises because most electric vehicles are 
charged by plugging them into an outlet that is connected to electric utility infrastructure. The mix 
of energy sources (fossil fuels vs. renewables) used by utilities varies significantly across the U.S. In 
the West and Southwest, where there is more solar energy in the mix, switching to an electric 
vehicle tends to reduce overall GHG emissions. However, in the Northern Midwest or East, where 
the grid mix uses more fossil fuels, switching to an electric vehicle would result in more GHG 
emissions than driving a fuel efficient gasoline vehicle. 

And there is still more bad news to dampen the enthusiasm surrounding the supposed promise of 
electric light-duty vehicles significantly reducing GHGs in the U.S.: sales of battery electric 
vehicles are projected to be relatively small. Figure 5 shows projections by the U.S. Energy 
Information Administration for Light-Duty vehicle sales out to 2050. As shown, electric vehicles 
in any form will only make up a humble fraction of all vehicles sold. 

 

Figure 5. Light-duty vehicle sales by technology/fuel.  
 

 
Battery electric vehicles are and will be only a relatively small fraction of light-duty vehicles for the foreseeable 
future. (Source: https://www.eia.gov/outlooks/aeo/pdf/AEO_Narrative_2021.pdf). 

Thus, the electrification of light-duty vehicles will not significantly reduce GHG emissions in the 
foreseeable future. And as this study addresses,a fundamentally better way to get people from one 
place to another while significantly reducing GHGs is still needed. 
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In addition to the minimal reduction of GHGs that can be expected from the present 
transportation paradigm, there are other significant problems that should be addressed in the 
search for a better way to move people, especially in urban areas. 

The urban landscape is dominated by the automobile and similar conveyances that compete with 
pedestrians and bicyclists for the same space at ground level. Transportation policy initiatives such 
as Complete Streets (Smart Growth America 2020; City of San José 2018) have arisen in an 
attempt to accommodate multiple modes of transportation (automobile, bicycle, pedestrian, and 
public transit) and get them all to play seamlessly together within existing rights-of-way, for 
example, re-striping of streets to include bike paths, installation of plastic bollards to force vehicles 
to turn corners more slowly, road ‘diets’ to lower vehicle speeds, etc. While well meaning, the idea 
that streets can be “designed and operated to enable safe use and support mobility for all users” 
(U.S. DOT, n.d.) cannot be realized unless vehicles are physically separated from unprotected 
humans by massive barriers (e.g., concrete). A four inch wide white or green line on the pavement, 
or even a six inch concrete curb will not prevent a distracted driver with a two ton vehicle from 
colliding with and seriously injuring someone sitting, walking, or riding just a few feet away 
(Dumbaugh & Li 2010; Fernandez 2014; Linder & Favro 2020). Figure 6 shows that U.S. 
statistics on traffic fatalities and injuries continue to be absurdly high year after year. Such statistics 
should shock the public into demanding action and innovation by city, regional, state, and federal 
officials to actually make streets safe for all users, particularly pedestrians and bicyclists. The 
authors maintain that streets will be made safe only when massive motorized vehicles are physically 
separated  from unprotected humans. 
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Figure 6. U.S. 2019 crash fatality and injury statistics. 

The fatality and injury rates do show a relatively steady decline over the last few decades, but the absolute numbers of fatalities 
and injuries remain unconscionably high. (Source:National Highway Traffic Safety Administration (NHTSA) Overview of 
Motor Vehicle Crashes in 2019. https://crashstats.nhtsa.dot.gov/Api/Public/Publication/813060). 

Not only is safety impacted by the current auto-centric paradigm, but the quality of urban life 
suffers too when vehicles and people compete for space in the urban landscape (Frazier 2019; 
Florida 2018). A new approach to urban mobility is necessary—one that can effectively address 
the most serious problems embedded within the status quo—those of GHG emissions, local noise 
and air pollution, lack of safety, and an urban form that is dominated by the automobile. The next 
section will present a bold new vision for truly sustainable transportation that solves the problems 
outlined in this section and forms the basis for the research described in the rest of this report. 

1.2 Solar-Powered Automated Transportation Networks: A Bold 
Step Forward 

Solar-powered automated transportation networks (solar ATN) have been proposed as the 
solution to the many problems baked into the current urban mobility paradigm (Swenson, 
1998; James 2004; Swenson 2007, 2012; Furman et al. 2014). Solar ATN is a relatively recent 
advancement in the evolution of automated fixed guideway transit which was first proposed in 
the 
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the 1950s (Furman et al. 2014). Figure 7 shows what a section of guideway2 and a station for a 
solar ATN system might look like. 

Figure 7. Solar-powered automated transportation network guideway and station. 

Photovoltaic solar panels are attached to a guideway structure below and along which vehicles travel on demand from origin to 
destination without intermediate stops. Stations (upper left) are “off-line,” so that passengers traveling to another destination do 
not have to stop. 

As described by the Advanced Transit Association (ATRA 2003), the main features of ATN 
consist of: 

• direct origin-to-destination service with no need to transfer or stop at intermediate
stations,

• small vehicles available for the exclusive use of an individual or small group traveling
together by choice,

• service available on demand for the user rather than on a fixed schedule,

• fully automated vehicles (no human drivers) available for use 24 hours a day, seven days a
week,

• vehicles captive to a guideway that is reserved for their exclusive use,

• small, narrow, and light relative to Light Rail Transit (LRT) and Bus Rapid Transit (BRT)
guideways usually elevated but also at or near ground level or underground, and

• vehicles able to use all guideways and stations on a fully connected network.

There has been abundant and enduring enthusiasm for ATN since the 1950s, but only a few 
examples have ever materialized; in particular, the Morgantown PRT at the University of West 
Virginia, the Ultra Global shuttle at London Heathrow Airport, the Suncheon Wetlands Skycube 

2 The word ‘guideway’ here refers to the elevated structure along which the ATN vehicles travel. 
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in South Korea, the Business Park Rivium GRT in the Netherlands, and the Masdar PRT in 
Masdar City, Abu Dhabi (Advanced Transit Association n.d.).  

The designs of ATN systems built in the past 10 years have improved from earlier 
implementations, but descriptions from more recent ATN promoters are often notional and 
fantastic rather than realistic. In the case of solar ATN specifically, there has been a lack of 
quantitative research to definitively show how solar-powered transportation is achievable, how 
much it would cost, and how it would function in an actual implementation. 

Additionally, a related problem is how to help stakeholders (community members, property 
owners, and government officials) visualize and be persuaded by solar ATN as a viable alternative 
to automobiles, buses, and light rail. Because ATN is so different from current modes of 
transportation in terms of its appearance and operation, it is easy to dismiss it as fiction rather than 
science. Considering this, combined with the fact that existing implementations of ATN are 
somewhat unique and arguably not scalable, as well as the lack of an ATN industry (Furman et al. 
2014), it is understandable that ATN has not gained traction with planners, transportation 
professionals, or the public at large. 

Thus, the research described in this report sought to address two questions: 

1. Can solar deliver the energy needed by a large ATN? 

2. How can available immersive, dynamic computer modeling approaches be leveraged to help 
stakeholders who are saturated in current paradigms understand and buy into radically new 
approaches? 

The investigators of this study proposed a realistic instantiation of a solar-powered ATN 
connecting the North and South SJSU campuses to answer the above research questions. Figure 8 
shows the North and South campus areas and the distance between them. 

A proposal was submitted to the Mineta Transportation Institute in April of 2020 to answer these 
two questions. The research was divided into two projects, which are described below as the Energy 
Project and the Visualization Project, respectively. The following chapters will address the research 
results, beginning with the Energy Project. 
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Figure 8. Study area.  

 
A solar-powered ATN to connect the two SJSU campus locations was proposed by the researchers as a realistic instantiation of 
the technology. 
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2. The Energy Project 
As mentioned in the previous chapter, the purpose of the Energy Project was to evaluate the 
feasibility of using grid-tied solar energy to power an ATN. The proposed energy system generates 
electricity with a canopy of solar photovoltaic (PV) modules above the guideway and stations. It 
also includes a means for energy storage such that overnight operation of the transit system can be 
sustained. Finally, it must interface with the electrical grid to export surplus solar electricity at 
times of overgeneration and import demanded electricity at times of under-generation. This study 
was conducted to characterize a viable energy system based on functional performance and evaluate 
its feasibility based on physical size and cost. Moreover, the emissions associated with such a 
system were examined. The methodology of this research is summarized in Figure 9, which is 
linear with an iterative optimization denoted by the dashed arrow, and is generalizable to any solar-
powered transit system. 

Figure 9. Flow chart summary of the energy project methodology.  

 

The dashed arrow denotes an iterative optimization loop. 

2.1 Route Identification 

The solar resource at all locations is dependent upon the latitude, local weather patterns, and 
surrounding features that bring shade. The first step in determining feasibility of powering the 
North-South campus ATN by solar energy was to establish the routing of the guideway. Figure 
10 shows the routing that resulted after several iterations. This route connects the North and South 
campuses of San José State University as an alternative to the diesel shuttle bus service currently in 
operation (the SJSU Park & Ride).3 The route is three miles long with ten potential station 
locations spaced at one-third-mile increments, outlined in red in Figure 10. A potential depot site 
is outlined in blue, which would be used for vehicle storage and maintenance. The thick magenta 
lines represent dual-way guideways, in which vehicles travel north and south on two parallel 
unidirectional tracks. The narrow red and blue lines represent northbound and southbound 

                                                
3 https://www.sjsu.edu/parking/help/shuttle.php  
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sections of one-way guideways, respectively. The route was designed for a vehicle line speed of 10 
m/s. 

Figure 10. Proposed ATN route connecting the North and  
South campuses of San José State University.  

 
Potential station locations are outlined in red, and the depot location 
is outlined in blue. Magenta, red, and blue route lines represent dual-
way, northbound, and southbound sections of guideway, respectively. 

2.2 Energy Demand Modeling 

With the ATN route identified, the first step toward designing the energy system was to quantify 
the energy demand. The ATN energy demand can be divided into two components: vehicle loads 
and station auxiliary loads. The vehicle loads represent the energy required for charging the electric 
ATN vehicles as they move through the stations. The station auxiliary loads represent the energy 
required to operate the infrastructure of the system, including lighting, computing, and 
maintenance equipment.  

The vehicle loads were characterized using two urban mobility simulation software packages, 
SUMO4 and SUMOPy.5 These tools were used to model the proposed routes, characterize 
ridership, and simulate the transient energy demand of the vehicles as they circulated the network. 

2.2.1 SUMO & SUMOPy 

SUMO is an open-source, microscopic, multi-model transit simulation package, first released in 
2001 by DLR (Lopez et al. 2018). Since then, it has been developed by 81 contributors from an 
international array of universities and industry partners (DLR 2021). As a microscopic simulator, 
SUMO individually models each vehicle and its dynamics, as opposed to macroscopic simulators 
that average the dynamics of traffic flows. This approach yields the fidelity required to accurately 
compute the kinetic, potential, and rotational energies of each vehicle, as well as the associated 

                                                
4 https://www.eclipse.org/sumo/  
5 https://sumo.dlr.de/docs/Contributed/SUMOPy.html  
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energy dissipations due to aerodynamic drag, rolling resistance, curvature resistance, and auxiliary 
loads (e.g., cabin HVAC, lights) (Kurczveil & Schnieder 2013). 

SUMOPy is a graphical user interface for SUMO, developed by Professor Joerg Schweizer of the 
University of Bologna (Schweizer 2013). Besides improving the usability of SUMO, it features a 
personal rapid transit (PRT) plug-in, which facilitates convenient modeling and simulation of 
ATNs with SUMO. The premier feature of this plug-in is a novel ATN vehicle management 
algorithm that leverages vehicle and passenger flow predictions to minimize passenger wait times 
at stations (Schweizer & Rupi 2017). SUMOPy also offers efficient tools for graphically defining 
traffic analysis zones (TAZs) and importing OpenStreetMap (OSM) route data (Dingil, 
Schweizer, Rupi, & Stasiskiene 2018). An implementation guide was developed throughout the 
modeling process to document the procedure of simulating an ATN with SUMO and SUMOPy. 
This guide is included in Appendix A. 

2.2.2 Route Modeling 

The first step in simulating the energy demand of the ATN was to model the route, shown in 
Figure 10. The foundation of the route model is a base layer of street, intersection, footpath, and 
building footprint data that characterizes the surrounding region in San José. This data was 
imported from OSM and then supplemented with a satellite image underlay via the Google Maps 
API, accessed through SUMOPy. Next, the SUMO NETEDIT application was utilized to create 
the ATN route. This entailed representing the proposed route with edges, junctions, and features 
termed “bus stop additionals,” which allow virtual passengers to board and alight vehicles at 
stations. An example is shown in Figure 11, in which a pair of offline stations are connected to a 
stretch of dual-way guideway as well as the surrounding footpaths for pedestrian access. Bus stop 
additionals are shown in green. 

Figure 11. Portion of the SUMO route model illustrating two offline stations  
connected to the dual-way guideway and surrounding footpaths. 

 
Acceleration and deceleration ramps are denoted. 

The route edges were configured with a line speed of 10 m/s. To maintain physical realizability, 
the route was modeled with dynamic constraints on corner radii, acceleration ramps, and 
deceleration ramps. Specifically, a minimum corner radius (𝑟𝑚𝑖𝑛) of 40 m was imposed throughout 
the route to ensure normal accelerations would not exceed 2.5 m/s2 '𝑎𝑛,𝑚𝑎𝑥+, the upper limit for 
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rider comfort in a vehicle with seated passengers (Anderson 1978). This value was determined 
with Equation (1) using the constant line speed (𝑣) of 10 m/s: 

𝑟-./ =
12

34,567
 								(1) 

Additionally, the acceleration and deceleration ramps, denoted in Figure 11, must be long enough 
for a vehicle to transition from rest to line speed (and vice versa) under the same 2.5 m/s2 
acceleration constraint. For the 10 m/s line speed, the minimum length for each ramp is 25 m 
(Furman 2019). 

2.2.3 Ridership Characterization 

For the route modeled, the next step was to characterize the ridership of the ATN. Ridership can 
be efficiently described by an origin-destination (OD) matrix, which defines the number of 
passengers traveling from each origin region to each destination region over the duration of the 
simulation. These origin and destination regions are termed traffic analysis zones (TAZs) and are 
represented with polygons on the base map of the route model. 

The OD matrices for the proposed ATN were derived from SJSU Park & Ride ridership data, 
which specifies the number of passengers that boarded each bus at each stop from September 3, 
2019, to February 27, 2020 (Cross 2020). This was the most recent data interval available that was 
not influenced by the COVID-19 pandemic, which anomalously halted ridership due to state-
mandated shelter-in-place orders. The average ridership between the North and South campuses 
was computed for each hour of the operational schedule to characterize the typical daily passenger 
flow, shown in Figure 12. The solid and dashed lines indicate trips that start at the South and 
North campuses, respectively.  

Figure 12. Characteristic daily ridership for the SJSU Park & Ride.  
 

 
The solid line represents northbound trips that begin at the south campus and the dashed line indicates 
southbound trips that begin at the north campus. Adapted from: (Cross 2020). 

Figure 12 also serves as a visualization of the 17 OD matrices that were implemented in SUMOPy, 
each representing one hour of simulated time and characterizing the number of trips between the 
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two TAZs (i.e., the North and South campuses). Both TAZs are illustrated in Figure 13, and each 
encompasses three stations of the proposed ATN. 

Figure 13. North and South campus TAZ definitions in SUMOPy.  

 
These zones characterize the locations of trip origins and destinations. 

2.2.4 Vehicle Parameters 

The SUMO energy simulation is largely dependent upon the physical characteristics of the 
vehicles, which were derived from literature on ATN and comparable vehicles. The values and 
references for the ten physical characteristics are presented in Table 1.  
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Table 1. Values and references for SUMO ATN vehicle parameters. 
Vehicle Parameter Value Units References 

Power Limit 18,750 W Based on Li-ion battery peak power of 250 W/kg and an 
anticipated 75 kg battery pack (Ehsani, Gao, & Emadi 2010) 

Mass 1,600 kg (Saiyed 2020) 

Front Surface Area 4 m2 (Furman 2016) 

Air Drag Coefficient 0.5 - Based on the air drag coefficient of a Volkswagen Westfalia camper 
van (Wikipedia 2021) 

Internal Moment of 
Inertia (equivalent mass) 

68 kg 4.25% of vehicle mass for direct-drive powertrain (Fajri, Prabhala, 
Lotfi, Ferdowsi, & Shamsi 2014) 

Radial Drag Coefficient 0.07 - Based on formulation for locomotives (Republic Locomotive 2016) 

Rolling Resistance 
Coefficient 

0.009 - (Furman 2016) 

Constant Auxiliary Power 3,500 W Allocated for cabin HVAC, cabin lighting, on-board computing, 
LCD displays, and electric doors (Furman 2016) 

Propulsion Efficiency 0.85 - Typical value for electric vehicles (Ehsani, Gao, & Emadi 2010) 

Recuperation Efficiency 0.3 - Recuperation efficiency of a Nissan Leaf (Doyle & Muneer 2017) 
 
2.2.5 Simulation Procedure 

With the model setup complete, the next steps were to initialize and run the simulation. The first 
phase of the initialization requires specifying the number of ATN vehicles to be deployed on the 
route. The second phase requires generating the virtual population of travelers from the OD 
matrix, in which one virtual traveler is created for each trip and assigned a corresponding origin 
and destination on the route map. The simulation process is summarized in Figure 14, where each 
generated virtual traveler walks to the nearest ATN station, boards an ATN vehicle, travels to the 
station nearest their destination, alights from the vehicle, and walks the remainder of their trip. As 
the model runs, the simulated dynamics are used to compute the transient power demand of each 
vehicle, which is summed with that of the other vehicles and averaged over the simulation duration. 
This average system power demand is then multiplied by the simulation duration to yield the 
average energy demand. 
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Figure 14. SUMO simulation process.  

 

Each virtual traveler walks from their origin to the nearest ATN station, boards an ATN vehicle, travels in the vehicle to 
the station nearest their destination, alights from the vehicle, and walks the remainder of their trip. 

The goal of the energy demand simulation was to compute the average vehicle energy demand for 
each hour of a typical day of operation. Thus, a one-hour simulation was run for each of the 17 
OD matrices visualized in Figure 12. The independent variable for these simulations was the 
number of ATN vehicles deployed on the route. This value was iteratively determined for each 
simulation, such that the average time that passengers spent waiting at stations was below two 
minutes during peak hours (i.e., 8:00 AM – 6:59 PM) and four minutes during off-peak hours 
(i.e., 7:00 PM – 7:59 AM). These wait times were selected to be less than that of the Taipei MRT, 
a rapid transit subway renowned for its reliability (Metro Taipei 2021). The wait times were also 
over 40% shorter than the surveyed average acceptable wait times for bus transit (Arhin et al. 2019).  

2.2.6 Energy Demand Results 

The simulations were run for each of the 17 OD matrices to characterize the average hourly energy 
demand for a typical day of operation. Since the proposed ATN is expected to operate 
continuously, the energy demand associated with the latest OD matrix (i.e., 10:00 PM – 10:59 
PM with six northbound trips and six southbound trips) was duplicated for the overnight hours 
for which no SJSU Park & Ride data was available (i.e., 11:00 PM to 5:59 AM). The resulting 
energy demand is shown in Figure 15, which represents the hourly DC electrical loads required to 
sustain vehicle operation. The annual energy demand profile was formed by duplicating the daily 
profile for each day of the year. 
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Figure 15. Simulated hourly energy demand for powering the ATN vehicles on  
the proposed route for a typical day of operation. 

 

 
 

2.3 Station Auxiliary Energy Demand Modeling 

The station auxiliary loads represent the AC electrical energy required to operate the ATN 
facilities. Namely, the stations and maintenance depot. These loads were estimated to be 10% of 
the net ATN energy demand, according to the convention used by the Santa Clara Valley 
Transportation Authority for evaluating the energy requirements of their light rail service (Santa 
Clara Valley Transportation Authority, 2004). One component of these loads is the electricity 
required for station lighting, which was modeled as 450 W per station. For reference, this value is 
one order of magnitude larger than the LED streetlight power requirement for local roads in San 
José (City of San José 2016). The station lighting was modeled as a dynamic load, as it was only 
applied from one hour before sunset to one hour after sunrise each day. An additional load of 10 
kW was added to the station lighting load as a reserve for operational and artistic lighting fixtures 
that could be installed along the guideway. This 10-kW load was supplemental to the station 
auxiliary loads and was applied during the same hours as the station lighting load. 

2.4 PV Energy Supply Modeling 

After modeling the energy demand of the ATN, the energy supply was characterized by simulating 
the generated electricity from the solar PV system. The PV system comprises a canopy of PV 
modules mounted above the guideway with additional modules above the stations, as illustrated in 
Figure 7. PV modules generate DC electricity through the mechanism of photovoltaic conversion, 
in which photons from incident solar irradiance excite electrons beyond the band gap energy of 
the PV cell material and establish an electric potential. The modeling and simulation of this process 
for the proposed ATN are subsequently detailed. 

2.4.1 PV Modeling 

A computational aid for designing PV canopies for solar-powered transit was implemented to 
model the PV system for the proposed ATN (Fogelquist, 2019). This program consisted of four 
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steps: (1) importing the route layout, (2) modeling the solar irradiance, (3) performing a shading 
analysis, and (4) simulating the PV canopy electricity generation. The first step loads the map data 
that characterizes the route and computes the orientation of each PV module in the system. The 
second step computes the position of the sun for every hour of the year and associates it with 
imported solar irradiance data measured at the San José International Airport (National Renewable 
Energy Laboratory 2010). The third step computes the regions of the PV canopy that are shaded 
by surrounding buildings for each hour of the year, based on imported building data from the City 
of San José (City of San José 2019). Finally, the fourth step couples the computed orientation, 
irradiance, and shading data with an equivalent circuit model to simulate the generated electricity 
from the PV modules. The effects of irradiance reflectance and absorptance, module soiling, air 
mass ratio, and cell temperature are incorporated in the simulation. The model was configured 
with the parameters for a SunPower SPR-P17-350-COM module6 due to its high performance 
and commercial availability, according to the characterization by the California Energy 
Commission (California Energy Commission 2019). 

2.4.2 PV Simulation 

The generated electricity from the PV canopy was simulated for every hour of the year. This data 
was used to compute the optimal module tilt angle that maximized the amount of annual incident 
irradiance, yielding 27° from horizontal for the proposed ATN. This value was implemented in a 
secondary PV simulation that represented the canopy as having a single-module width. The 
canopy was modeled in this way to facilitate the parameterization of its width for the full energy 
system simulation, allowing the generated electricity to be simply scaled by the number of modules 
across the canopy. This parameterization functions under the assumption that the canopy is planar 
(i.e., all modules above a straight segment of guideway have the same orientation). Fogelquist 
(2019) showed that this assumption is valid, even if the canopy is designed with a subtle curvature 
for aesthetic purposes. The total system power output was determined by summing outputs of the 
entire guideway canopy and all station rooftop canopies. 

An example output is shown in Figure 16, in which the hourly generated electricity from the PV 
system is plotted for two arbitrary days in April. The second day was cloudier than the first, as 
illustrated by the smaller power output and erratic profile. Additionally, no electricity generation 
occurs during night hours. 

 

  

                                                
6 https://us.sunpower.com/sites/default/files/media-library/data-sheets/ds-sunpower-p17-355-commercial-solar-
panels.pdf  
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Figure 16. Simulated electricity generation from a PV canopy with a  
single-module width for two arbitrary days in April.  

 

 

The power output on the second day is lower than that of the first due to increased cloud cover. 

 

2.5 Parameterized Energy System Simulation 

The purpose of the energy system simulation was to optimize the interactions between the energy 
supply, demand, storage, and grid subsystems. With supply and demand characterized, the power 
infrastructure was defined by proposing a configuration of necessary electrical components. The 
performance of each component was specified, and the simulation algorithm was subsequently 
developed. 

2.5.1 Power Infrastructure 

The power infrastructure comprises the electrical components necessary for the four energy 
subsystems (i.e., PV supply, ATN demand, battery storage, and grid) to interact. An AC-coupled 
system was proposed in which subsystems connect through a common AC bus, as illustrated in 
Figure 17. Note that this system is scalable insofar as it can represent a large central power station 
or one of many smaller distributed substations, with PV supply and ATN demand divided 
accordingly. The AC bus is the hub of the energy system and requires a transformer to coordinate 
the voltages of the four subsystems, subject to conversion losses. The power infrastructure 
associated with each subsystem is detailed below. 

• Solar PV Supply (shaded yellow in Figure 17): The PV system features a string-array 
configuration, in which strings of series-connected PV modules are wired in parallel to the 
AC bus. Each string has electrical inefficiencies from wiring, mismatched modules (i.e., 
performance differences between modules due to manufacturing tolerances), and module 
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degradation. Additionally, each string has an inverter that converts the generated DC 
electricity to AC, with associated conversion losses. Clipping losses are also introduced by 
the inverter, which occur when the DC power from the PV array surpasses the inverter 
rated input, causing the difference to be dissipated as heat. 

• ATN Demand (shaded blue in Figure 17): The station auxiliary demand is an AC load 
that is connected directly to the transformer. The vehicle demand is a DC load that requires 
conversion from AC through a rectifier, with associated losses. Additional ohmic and 
contact losses are incurred through the transmission of DC electricity through the 
conductor rail to the vehicles. 

• Battery Storage (shaded green in Figure 17): Battery packs are connected to the AC bus 
through bi-directional inverters, which rectify AC electricity to DC when charging and 
invert DC electricity to AC when discharging, subject to conversion losses in both 
directions. Battery efficiency is also incorporated and represents ohmic and electrochemical 
conversion losses. 

• Electrical Grid (shaded grey in Figure 17): The electrical grid is connected directly to the 
AC bus and serves as both an energy source and sink, depending on the available power 
from the PV and battery systems. As such, it provides energy to the ATN when the supply 
from the PV and battery systems is insufficient. Conversely, it absorbs all excess energy 
during events of overgeneration, after batteries have been fully charged. 

 
Figure 17. Proposed AC-coupled power infrastructure for the energy system.  

 

The solar PV supply is shown in yellow; ATN demand, in blue; battery storage, in green; electrical grid, in grey; and system 
losses, in orange. 

2.5.2 Energy System Characterization 

The characterization of the ATN demand and PV supply was detailed in Sections 2.2 – 2.4. The 
electrical grid subsystem acts as a pure source and sink, as described in Section 2.5.1, and therefore 
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has no parameters associated with it. The battery storage subsystem was characterized with three 
values: single-pack energy capacity, single-pack power limit, and number of battery packs in the 
energy system. The single-pack energy capacity (set to 245 kWhDC) is the amount of energy that 
a single battery pack will store when it is fully charged. The single-pack power limit (set to 130 
kWAC) is the maximum rate at which a single battery pack can be charged or discharged. These 
values were based on the specifications for a Tesla Powerpack,7 which was selected for its efficiency, 
scalability, and commercial availability. The number of battery packs was left as a parameter for 
the optimization of the energy system. Finally, a simulation constraint was added, termed the 
reserve state-of-charge (SOC), which represents the minimum amount of stored energy that must 
remain in the batteries. The reserve SOC is an engineering safety margin that will allow the ATN 
to remain sufficiently energized to deliver all active vehicles to the nearest stations in the event of 
an emergency power failure. A value of 10% of the total battery system capacity was selected. 

The power infrastructure was comprised of components that caused energy to be removed from 
the system through various mechanisms of dissipation. Accordingly, each component was 
characterized by a constant efficiency, which was multiplied by the component input power to 
yield the output power. These efficiencies are summarized with their references in Table 2. 

 

  

                                                
7 https://www.tesla.com/powerpack  
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Table 2. Energy system electrical component efficiencies and references. 
Subsystem Efficiency Value References 

Solar PV Supply Wiring 0.98 Default value in NREL System Advisor Model (National 
Renewable Energy Laboratory 2018) 

 Connections 0.995 Default value in NREL System Advisor Model (National 
Renewable Energy Laboratory 2018) 

 Module Mismatch 0.992 Recommended value for SunPower SPR-P17-350-COM 
module (SunPower Corporation 2016) 

 Module 
Degradation 

0.826 Warrantied 25-year degradation for SunPower SPR-P17-350-
COM module (SunPower Corporation 2016) 

 Inverter 0.96 Average value listed in (Messenger & Abtahi 2017) 

 Inverter Clipping 0.999 Result from clipping loss study in (Folsom Labs 2019) 

ATN Demand Rectifier 0.97 Estimated value for reversible thyristor-controlled rectifiers 
used in power substations for heavy rail transit (Gelman 2013) 

 Transmission 0.998 Approximated with the conductance rail resistance of 2.06E-5 
Ω/m listed in (Açıkbaş & Söylemez 2004)  

 Charging Contact 0.989 Approximated with a conservative contact resistance of 35 mΩ 
from (Ocoleanu, Manolea, & Cividjian 2010) 

Battery Storage Lumped Battery 
and Inverter 

0.938 Based on two-hour system round-trip efficiency for Tesla 
Powerpack battery (Tesla 2021) 

AC Bus Transformer 0.99 Based on U.S. Department of Energy transformer efficiency 
requirements (Garcia, Valencia, & Hausman 2016) 

 

2.5.3 Energy System Simulation Algorithm 

The energy system simulation algorithm was developed under the principle of conservation of 
energy, through which all generated electricity was accounted for as it was converted, dissipated, 
stored, and transferred to meet the ATN demand. The algorithm was developed from work by 
DiOrio, Freeman, & Blair, (2018), and the pseudocode is presented in Algorithm 1. The complete 
MATLAB script is included in Appendix D. 
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Algorithm 1. Pseudocode for energy system simulation. 
Energy System Simulation Pseudocode 

1 For each hourly time step of the year: 
2 If there is surplus generated electricity & batteries are not fully charged 
3 Charge batteries with surplus energy 
4 If battery power limit is reached 
5 Maintain battery power limit, and sink remaining 

surplus energy to grid 
6 If the batteries become fully charged 
7 Sink remaining surplus energy to grid 
8 Else if there is surplus generated electricity & batteries are fully charged 
9 Sink surplus energy to grid 
10 Else if there is insufficient generated electricity & batteries are not fully discharged 
11 Discharge batteries to power ATN 

12 If battery power limit is reached 

13 Maintain battery power limit, and source remaining 
demanded energy from grid 

14 If batteries become fully discharged 

15 Source remaining demanded energy from grid 

16 Else if there is insufficient generated electricity & batteries are fully discharged 

17 Source demanded energy from grid 

 

An example output of the energy system simulation is shown in Figure 18 for two arbitrary days 
in April, in which the power interactions between the PV supply, ATN demand, battery storage, 
and electrical grid subsystems are plotted for each hour. The PV supply curve—shown in yellow—
indicates the electrical power generated by the PV system. The ATN demand curve—shown in 
blue—represents the electrical power required to energize the ATN vehicles and facilities. The 
battery storage curve—shown in green—signifies the battery system charging (positive) and 
discharging (negative) power. The electrical grid curve—shown in grey—indicates the power that 
is sunk to the grid (positive) and sourced from (negative) the grid. 
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Figure 18. Simulated power interactions between the PV supply, ATN demand,  
battery storage, and electrical grid subsystems for two arbitrary days in April. 

 

 

The PV supply is shown in orange; the ATN demand is in blue; the battery storage is in green; and the 
electrical power sent to the grid is shown in grey. 

The energy system simulation algorithm can be better understood by examining how energy flows 
in each subsystem in Figure 18. As the sun rises on the first day, PV supply power increases and 
quickly surpasses the ATN demand. The surplus electricity is used to charge the batteries, 
indicated by the positive region of the green curve. The batteries become fully charged shortly after 
midday, forcing all surplus energy to be sunk to the grid, as illustrated by the positive region of the 
grey curve. This is also shown in Figure 19, where the battery state-of-charge (SOC) reaches 100% 
after noon. As the sun sets, the PV supply decreases until it can no longer power the entire ATN. 
At this point, the batteries begin to discharge and become the sole source of power for the ATN 
through the night. The second day yields less PV supply power due to increased cloud cover, yet 
there is still a surplus of generated electricity during midday. The batteries are charged during this 
time, as indicated by the positive region of the green curve in Figure 18, but only reach 62% SOC, 
according to Figure 19. As the sun sets, the PV system can no longer sustain ATN operation, and 
the batteries become the primary energy source. The batteries discharge to the reserve SOC of 
10%, and then the grid becomes the sole energy source, illustrated by the negative region of the 
grey curve in Figure 18. The grid powers the ATN through the night and the cycle continues as 
the sun rises the following morning. 
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Figure 19. Simulated battery system SOC for two arbitrary days in April.  
 

 

The SOC is the percentage of remaining charge in the battery, which increases during charging and decreases 
during discharging. 

The energy system simulation was parameterized by the number of PV modules across the width 
of the canopy and the number of battery packs distributed throughout the network. These 
parameters were varied to optimize the performance of the system. The results of the optimization 
are presented in the following section. Additionally, the cost of constructing the energy system was 
estimated according to the benchmarks published in Feldman, et al. (2021).  

2.6 Results 

The parameterized energy system was simulated to identify the optimal PV canopy width and 
battery capacity. The feasibility of this configuration was evaluated, and the associated costs and 
emissions were compared with that of a grid-powered version of the proposed ATN and the 
current SJSU Park & Ride service. 

2.6.1 Energy System Optimization 

The energy system was simulated over the annual cycle with parameterized PV canopy widths and 
battery system capacities. The PV canopy width was varied from 3 to 11 modules at 1-module 
increments (i.e., 2.62 – 8.34 MW rated output at 0.715-MW increments for the proposed ATN). 
The upper limit of 11 modules was a physical constraint imposed by the typical 10-meter width of 
city streets; a wider PV canopy simply would not fit between the existing buildings and trees of the 
urban fabric. Additionally, the canopy width could not exceed 6 modules for segments of one-way 
guideway (shown in red and blue in Figure 10) because the guideway structure was too narrow to 
provide a stable foundation for wider canopies. Thus, the canopy width was capped at 6 modules 
for these segments, while wider canopies could be simulated throughout the remainder of the 
route. In the simulation, the number of battery packs in the system was varied from 10 to 150 at 
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10-pack increments (i.e., 2.45 – 36.75 MWh capacity at 2.45-MWh increments). The total annual 
energy sourced from the grid for each configuration is shown in Figure 20, with large values (shown 
in yellow) representing a strong dependence on the grid and small values (shown in blue) 
representing a weak dependence. 

Figure 20. Surface plot of annual energy sourced from the grid for 135 different  
energy system configurations.  

 

 

In the simulation, the rated output of the PV system was varied from 2.62 to 8.34 MW at 0.715-MW 
increments, and the capacity of the battery system was varied from 2.45 to 36.75 MWh at 2.45-MWh 
increments. 

According to Figure 20, the PV rated output had the largest influence on the grid dependence of 
the energy system. A smaller grid dependence is favorable because it improves the reliability of the 
ATN in the event of a grid failure while reducing the GHG emissions associated with imported 
fossil-fueled energy. However, complete grid independence is impossible because the required PV 
canopy would be unfeasibly wide. A grid connection is also a necessary sink for surplus energy 
during events of overgeneration. Figure 21 shows the annual energy sunk to the grid for each 
energy system configuration, indicating that widening the PV canopy sunk considerably more 
energy to the grid than it prevented from being sourced from the grid. This became uneconomical 
for wider PV canopies because the expense of the additional modules outweighed the cost savings 
associated with sourcing less energy from the grid, even when the profit from selling surplus energy 
to the grid was considered. For the current commercial buying rate of 14.08¢/kWh for grid-
sourced energy (Electricity Local 2021) and average selling rate of 3¢/kWh for grid-sunk energy 
(PG&E 2021), the most economical PV canopy configuration had a width of 8 modules (i.e., 6.2 
MW rated output). 
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Figure 21. Surface plot of annual energy sunk to the grid for 135  
different energy system configurations.  

 

 

In the simulation, the rated output of the PV system was varied from 2.62 to 8.34 MW at 0.715-MW 
increments, and the capacity of the battery system was varied from 2.45 to 36.75 MWh at 2.45-MWh 
increments. 

With the PV canopy width determined, the next step was to identify the optimal battery system 
capacity. The grid interactions and estimated cost of the energy system were plotted in Figure 22 
for an 8-module-wide PV canopy over a battery capacity range of 2.45 to 68.60 MWh. The annual 
energy sourced from the grid is represented by the solid red line, while the annual energy sunk to 
the grid is represented by the dashed green line. Error bars are included for a ridership uncertainty 
of ±15%, and the estimated energy system cost is shown in orange. 

 

 
  



 

 33 

Figure 22. Energy system grid interactions for an 8-module-wide PV canopy  
and parameterized battery system capacity of 2.45 to 68.60 MWh.  

 

 

The annual energy sourced-from and sunk to the grid are shown in red and green, respectively, under a ±15% 
ridership uncertainty. The estimated cost of the energy system is shown in orange. 

The red and green grid interaction curves have steep negative slopes at battery capacities of less 
than 10 MWh, indicating the energy system achieved considerable reductions in grid dependence 
for small increases in battery capacity. Conversely, both curves have shallow negative slopes at 
battery capacities above 10 MWh, indicating a nearly constant grid dependence despite large 
increases in battery capacity. Because the cost of the energy system increased linearly with battery 
system capacity, it became uneconomical to use large battery capacities as performance gains were 
minute. Thus, the optimal capacity which balanced grid dependence with system cost was 9.8 
MWh (i.e., 40 battery packs), at the knee of both grid interaction curves. 

The optimized energy system is physically viable, as the 8-module-wide PV canopy has a width of 
7 meters, which is sufficiently narrow to fit between the 10-meter corridors in the existing urban 
landscape. Additionally, the battery system at each station has a sufficiently small footprint of 6.9 
square meters and a height of 2.2 meters, which, for reference, is approximately the same spatial 
envelope of eight standard vending machines. The energy system is comparable in size and cost to 
a small utility-scale PV power plant (Feldman, et al. 2021) and was observed to export 
approximately twice the energy that it imported from the grid. The optimized energy system was 
thus deemed feasible, and its attributes are summarized in Table 3. 
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Table 3. Attributes of the feasible, optimized energy system. 
Attribute Value Units 

Dual-Way Guideway PV Canopy Width 8 Modules 
One-Way Guideway PV Canopy Width 6 Modules 

Total Number of PV Modules 17,699 Modules 
PV System Rated Output 6.2 MW 

Total Number of Battery Packs 40 Packs 
Battery System Capacity 9.8 MWh 

Annual Energy Sourced from Grid 957 MWh 
Annual Energy Sunk to Grid 2,000 MWh 

Estimated Energy System Cost $11.4 million USD 
 
Three important observations can be made from Figure 22. The first is that the error bars of the 
grid interaction curves do not overlap, indicating that the annual energy sourced from the grid will 
not exceed the annual energy sent to the grid under a ±15% ridership uncertainty. Therefore, 
because the energy collected is renewable, it is feasible to create a transportation system with net-
zero GHG emissions. The important implication is that there is a way to eliminate the use of fossil 
fuels in transportation. Second, the error bars are wider for the curve that represents energy sent 
to the grid, indicating that the quantity of energy sent to the grid is more sensitive to ridership 
uncertainty than the quantity of energy sourced from the grid. This was attributed to the fact that 
energy is only sent to the grid during the day—when the PV system is generating surplus 
electricity—and energy is predominately sourced from the grid during the night to sustain 
operation after the batteries have been discharged. Since passenger trips primarily occur during the 
day, changes in ridership have a greater influence on the daytime energy demand and the energy 
sent to the grid. Third, the spans of the error bars are unchanging for battery system capacities 
greater than 10 MWh. This indicates that the influence of ridership on the grid interactions is 
largely insensitive to changes in the battery capacity. Thus, an increased ridership cannot be 
accommodated by installing additional battery packs throughout the energy system; it would 
require additional PV modules to be installed. This is an important insight because PV modules 
cannot be installed as conveniently, due to the height and fixed structural design of the canopy 
racking. Therefore, it is recommended that the PV canopy be sized to accommodate the peak 
ridership that is anticipated over the expected life span of the energy system. 

2.6.2 Cost Comparison 

With the solar-powered ATN energy system deemed feasible from physical and performance 
standpoints, an analysis was conducted to determine if it could be economically competitive with 
alternative configurations. Namely, a grid-powered version of the proposed ATN and the SJSU 
Park & Ride. A comparison with the grid-powered version of the proposed ATN was conducted 
to determine if it would be economically advantageous to power the ATN with solar energy as 
opposed to simply purchasing all electricity from the grid. Moreover, a comparison with the SJSU 
Park & Ride was conducted to determine if the solar-powered ATN would be a financially 
competitive replacement for the existing service. 
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Beginning with the comparison of the grid-powered ATN, both systems were evaluated by their 
levelized cost of energy (LCOE). The LCOE is a common metric for financial assessments of 
energy systems and is formulated in Equation 2 (U.S. Department of Energy 2015). 

𝐿𝐶𝑂𝐸 =
∑/>?@ A𝐼> + 𝑀> + 𝐹>

(1 + 𝑟)> G

∑/>?@ A 𝐸>
(1 + 𝑟)>G

									(2)	 

The numerator describes the lifetime costs of the system, comprised of investment expenditures 
(𝐼𝑡), operations and maintenance expenditures (𝑀𝑡), and transactions with the local utility 
company (𝐹𝑡). The denominator represents the quantity of energy that characterizes the system 
(𝐸𝑡), selected here to be the annual ATN energy demand. The numerator and denominator terms 
incorporate inflation through the discount rate (𝑟), and the summations are performed for each 
year (𝑡) over the entire life of the system (𝑛). The LCOE was calculated with the economic 
assumptions and simulated values summarized in Table 4. 
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Table 4. Inputs and references for the LCOE calculation. 
Input Value Units References 

Discount Rate 2.7 % From utility-scale levelized cost of solar-plus-
storage analysis in (Feldman, et al. 2021) 

Life of System 30 years From utility-scale levelized cost of solar-plus-
storage analysis in (Feldman, et al. 2021) 

Operations & Maintenance 
Costs 

27 $/kW/yr From utility-scale levelized cost of solar-plus-
storage analysis in (Feldman, et al. 2021) 

PV System Rated Output 6.2 MW Simulated value 
Annual Energy Purchased 

from Utility 
957 MWh/yr Simulated value 

Cost of Energy Purchased 
from Utility 

140.8 $/MWh Current commercial rate in San José, CA 
(Electricity Local 2021) 

Annual Energy Sold to 
Utility 

2,000 MWh/yr Simulated value 

Profit from Energy Sold to 
Utility 

30 $/MWh Average rate for selling PV-generated 
electricity to the local utility (PG&E 2021) 

Annual Energy Demand of 
ATN 

6,980 MWh/yr Simulated value  

Capital Cost $11,379,105 USD Computed from cost benchmarks in (Feldman, 
et al. 2021) 

10-Year Follow-On 
Investment Cost Percentage 

4.3 % From utility-scale levelized cost of solar-plus-
storage analysis in (Feldman, et al. 2021) 

20-Year Follow-On 
Investment Cost Percentage 

3.2 % From utility-scale levelized cost of solar-plus-
storage analysis in (Feldman, et al. 2021) 

Interest Rate 8 % Modeling assumption from levelized cost of 
storage analysis in (Lazard 2018) 

Initial Debt Percentage 20 % Modeling assumption from levelized cost of 
storage analysis in (Lazard 2018) 

Initial Equity Percentage 80 % Modeling assumption from levelized cost of 
storage analysis in (Lazard 2018) 

 

The LCOE of the proposed solar-powered ATN was $130.1/MWh, which was 7.6% less than 
the $140.8/MWh associated with the grid-powered version. Thus, it would be more economical 
to power the ATN with the optimized PV-battery energy system than to purchase all required 
electricity from the grid. 

For the comparison between the solar-powered ATN and the SJSU Park & Ride, the costs were 
evaluated per passenger-mile due to the different routes and operating schedules of each service. 
The energy cost of the solar-powered ATN was determined by multiplying the LCOE by the 
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simulated annual energy demand and dividing by the annual passenger mileage.  The annual 
passenger mileage was estimated to be 5.9 million passenger-miles per year, based on the following 
assumptions: 

1) The average trip distance between the North and South campuses is 2.4 miles, based on 
the proposed route configuration in Figure 10. 

2) The daily number of vehicle trips is 2,262, based on the SUMO/SUMOPy simulation 
results under the SJSU Park & Ride daily ridership profile in Figure 12. 

3) The annual number of vehicle trips was determined by multiplying the daily number of 
vehicle trips by 365 days per year.  This assumption represents the continuous operation of 
the ATN. 

4) The annual number of passenger trips was determined by multiplying the annual number 
of vehicle trips by three passengers per vehicle, to reflect the capacity of the ATN vehicles.  
This assumption represents an average of three passengers occupying each of the eight-
seated ATN vehicles for every vehicle trip. 

The energy cost of the SJSU Park & Ride was derived from the ridership data (Cross 2020) and 
expense data (Renelle J., personal communication, June 24, 2016) provided by the university. 
Figure 23 compares the energy costs associated with each service, indicating that the solar-powered 
ATN energy expenses are projected to be 26% less than that of the SJSU Park & Ride. Thus, the 
optimized PV-battery ATN energy system was deemed to be economically feasible, as it is 
predicted to be more affordable than the energy expenses from the existing service. 

 
Figure 23. Energy cost per passenger-mile for the proposed solar-powered  

ATN and SJSU Park & Ride services.  
 

 

Source: (Cross, 2020) & (Renelle J., personal communication, June 24, 2016). 
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2.6.3 Emissions Comparison 

The final comparison evaluated the carbon dioxide (CO2) and particulate matter 2.5 (PM2.5) 
emissions for the proposed solar-powered ATN, the grid-powered version of the proposed ATN, 
and the SJSU Park & Ride. As detailed in Section 1.1, CO2 is the predominant GHG emission 
associated with anthropogenic climate change. PM2.5 emissions have been linked with respiratory 
and cardiovascular ailments, as well as environmental impacts such as reduced visibility and acid 
rain (U.S. Environmental Protection Agency 2021). Thus, it is important to mitigate both types 
of emissions to protect the health and safety of the public while minimizing environmental harm. 
For this comparison, the emissions were evaluated per passenger-mile to account for route and 
schedule differences between the ATN and SJSU Park & Ride. 

The CO2 emissions for the solar-powered ATN were computed by multiplying the annual amount 
of energy sourced from the grid (i.e., 957 MWh/yr) by the utility CO2 rate of 210 lb-CO2/MWh 
(City of San José 2019) and dividing by the estimated annual passenger mileage (i.e., 5.9 million 
passenger-miles per year from Section 2.6.2). These emissions were offset through the supply of 
clean solar energy to the grid during periods of PV overgeneration, in which solar energy effectively 
replaced the energy that the utility would have generated with a fossil-fueled power plant. These 
CO2 reductions were calculated in the same way as the emissions, using the annual amount of 
energy sunk to the grid (i.e., 2,000 MWh/yr) instead of the annual amount of energy sourced from 
the grid. The CO2 emissions from the grid-powered ATN were computed with the total annual 
energy demand (i.e., 6,980 MWh/yr), as would be the case if all energy were purchased from the 
utility. Finally, the SJSU Park & Ride CO2 emissions were calculated by multiplying the annual 
amount of burned diesel (i.e., 21,000 gallons) by the CO2 rate of 22.4 lb-CO2/gallon-diesel (U.S. 
Energy Information Administration 2016), and dividing by the annual passenger mileage (i.e., 
322.4 thousand passenger-miles per year). Figure 24 summarizes the results for each system, with 
emissions and reductions shown in red and green, respectively. 
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Figure 24. CO2 emissions per passenger-mile for the solar-powered ATN,  
grid-powered ATN, and SJSU Park & Ride.  

 

 

Emissions and reductions are shown in red and green, respectively. 

According to Figure 24, the solar-powered ATN had the lowest CO2 emissions—86% lower than 
the grid-powered ATN and 98% lower than the SJSU Park & Ride. This system also yielded CO2 
reductions that were 2.1 times greater than its emissions, making it the only system to generate a 
net reduction in CO2. Thus, the proposed solar-powered ATN can feasibly attain the goal of 
carbon neutrality. 

The PM2.5 emissions were computed in the same way for the solar- and grid-powered ATNs, using 
the utility PM2.5 rate of 0.0314 lb-PM2.5/MWh (U.S. Environmental Protection Agency 2020). 
The PM2.5 emissions for the SJSU Park & Ride were determined from the PM2.5 rate of 0.23 g-
PM2.5/mile for heavy-duty diesel vehicles (Bureau of Transportation Statistics 2018). Figure 25 
compares the results for each system. 
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Figure 25. PM2.5 emissions per passenger-mile for the solar-powered ATN,  
grid-powered ATN, and SJSU Park & Ride.  

 

 

Emissions and reductions are shown in red and green, respectively. 

Figure 25 presents a similar trend to that of Figure 24, revealing the solar-powered ATN to 
produce 86% less PM2.5 emissions than the grid-powered version and 98% less than the SJSU Park 
& Ride. It also yielded PM2.5 reductions that were 2.1 times larger than its emissions, making it 
the only system to generate a net reduction in PM2.5. Therefore, the proposed solar-powered ATN 
was deemed to provide considerable reductions in particulate matter air pollution, which would 
greatly benefit the health of the surrounding community and environment. 

2.7 Conclusions (Energy Project) 

To summarize, the PV-battery energy system was modeled, parameterized, and optimized for the 
proposed solar-powered ATN which connects the North and South campuses of SJSU. The 
energy demand of the ATN was characterized through simulation with SUMO and SUMOPy, 
using ridership data from the SJSU Park & Ride. The energy supply from the PV system was 
characterized through simulation with a previously developed computational aid. The optimized 
energy system had a PV rated output of 6.2 MW, a battery system capacity of 9.8 MWh, and an 
estimated cost of $11.4 million USD, comparable to that of a small utility-scale PV power plant. 

The feasibility of the optimized energy system was evaluated with respect to its physical 
dimensions, performance, cost, and emissions. Physically, the proposed system had a PV canopy 
width of 7 meters, which was narrow enough to integrate with the existing buildings and trees in 
the urban fabric. The battery packs were also sufficiently sized to fit within each station, with a 
volume of 15.2 cubic meters per station. Regarding performance, the energy system adequately 
met the ATN demand and sourced only 14% of the total demand from the grid. For ridership 
uncertainties of up to 15%, it was observed that the ATN would export more energy to the grid 
than it would import. The LCOE of the solar-powered ATN was 7.6% less than that of the grid-
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powered version, indicating that it would be more economical to power the ATN with the 
proposed PV-battery energy system than with energy purchased from the grid. Additionally, the 
energy costs associated with the solar-powered ATN were projected to be 26% less than those of 
the SJSU Park & Ride. Finally, the solar-powered ATN yielded CO2 and PM2.5 emissions that 
were 98% less than those of the SJSU Park & Ride. The solar-powered ATN was the only system 
to yield a net reduction in both types of emissions, indicating that it is a viable means for reducing 
GHG emissions and particulate matter air pollution in the transportation sector. 

The specifications for the optimized energy system and the SUMO/SUMOPy simulation results 
were used to derive the following solar-powered ATN design guidelines, characteristic of the 
proposed north-south campus route: 

1. Average Guideway Distance Between Stations: 500 m 

2. Average PV Rated Output per Kilometer of Guideway: 1.24 MW 

3. Average Battery Capacity per Kilometer of Guideway: 1.96 MWh 

4. Average Vehicle Energy Demand per Passenger-Kilometer: 0.10 kWh/passenger-km, 
determined by dividing the average simulated ATN vehicle power demand (i.e., 5.58 kW) 
by the average simulated ATN vehicle speed (i.e., 18 km/hr) and the assumed average 
vehicle occupancy of three passengers per trip.  For reference, the average ATN vehicle 
energy demand is 94% lower than the average SJSU Park & Ride vehicle energy demand 
of 1.6 kWh/passenger-km, determined by multiplying the annual fuel consumption (i.e., 
21,000 gallons) by the diesel energy content of 40.45 kWh/gallon (M.J. Bradley & 
Associates 2014) and dividing by the annual number of passenger-kilometers traveled (i.e., 
518.9 thousand passenger-km per year). It is also 84% less than the average gasoline 
automobile energy demand of 0.65 kWh/passenger-km (M.J. Bradley & Associates 2014). 

The following design considerations were revealed during the energy system analysis: 

1. It is not practical for the solar-powered ATN to be configured without a grid connection, 
as the system would require an unfeasibly large PV canopy and battery capacity. The grid 
connection also provides an avenue for sending surplus electricity produced by the PV 
canopies to the grid and the potential for the energy system to improve grid reliability (e.g., 
the generation and storage capacities of the ATN energy system could help stabilize the 
grid during rolling blackouts or provide power to critical infrastructure during emergency 
events). 

2. The additional energy demand from increased ridership cannot be accommodated by 
installing more battery packs throughout the energy system. The number of PV modules 
in the system would need to increase, which is much less convenient, as new modules 
cannot be added to the canopy without redesigning the racking structure. Thus, conducting 
a thorough ridership analysis is recommended in the planning stages of any solar-powered 
ATN project such that the PV canopy may be sized to accommodate the maximum 
projected ridership over the anticipated 30-year life of the energy system. Alternatively, 
hardware provisions could be incorporated in the racking design to facilitate the installation 
of additional modules after the system is constructed.  
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In sum, it is feasible to maintain 24/7 ATN operation with a grid-tied PV-battery energy system. 
This will yield substantial reductions in emissions8 while remaining economically competitive with 
existing modes of transit and local utility rates. Therefore, solar-powered transit systems are 
strongly recommended as an effective means for decarbonizing and depolluting the transportation 
sector. 

 

  

                                                
8 The reductions in CO2 emissions from the Superway system are significantly larger than can be obtained 
by other methods. For example, many climate activists advocate for planting more trees to capture carbon. 
The typical tree will absorb about 10 kg of carbon per year. It would take planting one tree every square 
meter over an area the size of the current Park & Ride lot (about 21,300 trees and lots of water) every year 
to come close to matching the reduction in CO2 that the Superway system will achieve. 
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3. The Visualization Project  
Broadly speaking, visualization is a communicative process that relies upon the transference of 
encoded meanings from creators and organizers of information to users and receivers. Visualization 
tools are unique because they can integrate and organize different types of information—
quantitative data in the form of graphs and charts, qualitative data such as perspective renderings, 
and spatial data such as maps, sound, and movement.Tufte, a world renowned information 
visualization expert, proposes that visualization is as much an art as it is a science, where the 
processes of arranging data and information in order to achieve representation, communication, 
and explanation are consistent, regardless of the nature of the substantive content or the 
technologies used to display the information (Tufte, 2001). In other words, every successful 
visualization strategy and product is a purposeful design intended to help the viewer connect with 
their prior experience and understanding. Architects and planners use many different visualization 
tools to enable different audiences (user groups) to make sense of information.  

The original plan for the Visualization Project was to use a virtual reality (VR) modeling tool such 
as Encitra to create a realistic and dynamic visualization of the proposed SJSU campus solar ATN. 
Moreover, part of this research work was to see how to streamline and mainstream a modeling tool 
like Encitra to make it more accessible for those without extensive training or background in 
software to develop models and use them effectively in the decision-making process concerning 
potential new transportation systems. Figure 26 shows the workflow that served as the initial 
roadmap for carrying out the Visualization Project. The intended first step was to use geometrically 
rectified aerial photographs (orthophotos) and digital elevation models (DEM) as the data 
foundation. The next step was to apply software tools such as Infraworks9 and SketchUp10 with 
mapping and site information to build a 3D area model along the guideway route. These software 
models would in turn be imported into open source Unity11 as a virtual reality development 
platform, and with Unity, create videos and VR interactive models. 

  

                                                
9 https://www.autodesk.com/products/infraworks/overview?term=1-YEAR  
10 https://www.sketchup.com/  
11 https://unity.com/  
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Figure 26. Planned workflow for developing a virtual reality (VR) model of the solar ATN. 

 

For reasons that will be discussed in this chapter, the research team pivoted away from using virtual 
reality software and instead developed still renderings and a video—crafted to more thoroughly 
describe the need for a solar ATN and to depict a typical rider’s experience. 

3.1 Guideway Route and Station Placement 

The first step carried out in the Visualization Project was to define the guideway route between 
the North and South campuses. ArcGIS was used extensively to map, study, and document the 
guideway route. Route planning followed a few principles provided below to minimize the impact 
of installing the guideway structure in existing rights of way. To the extent possible: 

1. Avoid guideway placement that would take away car traffic lanes. Prioritize the guideway 
route along (1) parking lanes, (2) sidewalks, and (3) green belts. 

2. Avoid conflict with street trees. 

3. Avoid areas with dense electric cables and poles. 

4. Identify a vacant space as a potential station site approximately every 400 - 500 m along 
the route. 

5. Prevent overlap between guideways. 

The representation of the guideway in area models and renderings was proportioned using previous 
design work by SJSU MS student Liwei Lu, whose MS project focused on the design and 
fabrication of a guideway for a commercial implementation of a solar ATN (Lu 2020). Figure 27 
below shows the approximate dimensions and what a dual-direction guideway (left side) and 
single-directional guideway (right side) look like, per Liwei’s design. It was extremely important 
to use realistic proportions for the guideway in route planning because the chosen streets needed 
to be wide enough for the guideway to fit within existing buildings, trees, and utilities. The 
associated station designs were dimensionally accurate so that the visualizations would be 
believable.  



 

 45 

The first few attempts to lay out the route used single-direction guideways, but advice from 
practitioners in the proto-ATN industry was to make more use of dual-direction guideways, as 
fewer support posts would be needed, and that would lead to less disruption during construction 
and lower overall costs. 

Figure 27. Dual-direction and single-direction guideway design by Liwei Lu (2020). 

 
 

The final guideway route is shown in Figure 28 below. The thicker magenta lines indicate dual-
direction guideways, and the thinner blue and red lines indicate single-direction guideways 
(northbound and southbound, respectively). 
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Figure 28. Final guideway routing.  

 
The thicker magenta lines indicate dual-direction guideways, and the thinner blue 
and red lines indicate single-direction guideways (northbound and southbound, 
respectively). 

As listed earlier, stations in an ATN are ideally placed approximately 400 - 500 m apart, close 
enough for users to walk to them. For the route shown above, ten stations were planned along the 
route. Due to the time and budget constraints of this project, however, it was subsequently decided 
to model only three of these stations in detail: one at the north in between the parking structure at 
7th and San Salvador Streets, one at the south, adjacent to the new parking structure (currently 
under construction), and one approximately midway between the North and South campuses at 
the corner of East Reed and 2nd Streets.  

3.2 Strategy for Crossing Highway 280 

One of the major challenges in determining the guideway route between the North and South 
campuses was how to cross Interstate Highway 280. The team did not consider going over the 
highway (or tunneling beneath) because of high costs, but instead considered multiple options with 
existing passageways underneath the elevated highway structure. Work by student teams in the 
summer of 2016 identified five potential sections with passageways under the highway, as shown 
in Figure 29 below. 
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Figure 29. Potential passageways underneath Highway 280.  

 
Student research from 2016 identified five locations where an ATN guideway could go (Oliveira, et al. 
2016). Fieldwork identified the four most feasible passageways, which are shown in Figure 30: S 2nd street 
and S 3rd street, as well as the two alleys between S 1st and S 2nd Streets and between S 2nd and S 3rd 
Streets. The reasons supporting these selections are explained below. 

Figure 30. The four most feasible passageways underneath Highway 280. 

  
Among the five passageways below Highway 280 shown in Figure 30, the sections between 2nd 
street and 3rd street have the highest elevation, especially 3rd street. Furthermore, in order to 
follow the routing guideline #1 [prioritizing the guideway route along parking lanes], existing 
parking lanes on both sides of 2nd St. and 3rd St. can be repurposed. Moreover, such an open 
space allows for more leeway in determining the guideway curve radius in terms of route planning, 
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and there is no need to demolish current structures when the guideway is installed. Photographs 
and additional details from site surveys are included in Appendix B. 

3.3 Building the Area Model 

The next step in the visual modeling process was to build a virtual area model in Infraworks. 
Architects from SIU developed a method to apply photorealistic facades to buildings along the 
guideway route in Infraworks or Sketchup. Figure 31 shows an example of a building on the 
guideway route where a photorealistic facade has been applied. Details on this process are included 
in Appendix C. 

Figure 31. Photo-realistic facade added to a 3D model in SketchUp. 

 
 
It gradually became clear, however, that the workflow to develop the entire area model from Figure 
29 was going to be too time-consuming and data-intensive to carry out for all of the buildings 
along the guideway route. While some photos for the building facades could be extracted from 
Google Street View, many others would need to be taken on-site, uploaded, and edited, and this 
would have taken more time than had been budgeted for in the proposal. An extensive search was 
conducted to obtain commercially available Google Earth-like 3D datasets for the study area in 
order to short-circuit the time to generate photorealistic building data manually. However, it was 
discovered that regardless of whether the 3D data was built in-house or purchased, the resulting 
area model was going to be so large that it would have required much more computer memory and 
processing power than was going to be feasible to build out a VR model of the entire guideway 
network. It was at this point that an alternate approach was taken to generate a compelling visual 
story of solar ATN. This alternate approach is outlined in the next section. 

3.4 An Alternative Approach to Visualization 

As indicated above, when it became clear that the initial approach to the Visualization Project was 
not going to produce the expected results, the team realized that it was necessary to go back to a 
more careful reconsideration of all the elements of the system before jumping ahead to simply build 
a VR world. In due course, VR could still be used as a tool, not just to visualize, but to actually 
perform usability tests to verify if the research conclusions were accurate or not. Under the 



 

 49 

circumstances, the team realized it was premature and beyond the scope of this project to build a 
VR world before a competent urban design was solidified. 

It is not uncommon for the front-end of a project to be full of unclear objectives and procedures, 
especially when the complexity and scope of the many tasks necessary to achieve the main goal 
have not been thoroughly evaluated. So, the Visualization team was expanded to include design 
professionals who were familiar with automated transit networks (ATN) and had previously 
prepared a preliminary ATN system design for San José. This team, consisting of architects, urban 
planners, engineers and industrial designers, was assembled by RODZMAS, a design and 
innovation consultancy based in Toluca, México.12 

The expanded team examined the assumptions, presuppositions, biases, data, and unrefined ideas 
that had been developed up to that point. Once the project was subjected to such assessment, 
crucial information was discovered, and the team began making steady and consistent progress 
toward the goals of the Visualization Project. 

This assessment was carried out by applying qualitative criteria that permitted a general 
understanding of the dimensions and complexity of the project and its requirements in terms of 
expertise, infrastructure, economic resources, and objective information. To begin, the 
RODZMAS team posed a series of questions. This matrix (Table 5 below) was completed with 
concrete, quantifiable information. 

Table 5. Spartan Superway Visualization Project Design Questions 
Why? The reasons or main motivations behind the project had to be explained 

What? A precise description of the objective had to be defined 

Who? A detailed list of stakeholders and collaborators had to be put together  

Where? A detailed assessment of infrastructure as well as a field reconnaissance had to be performed  

How? A thorough and realistic assessment of resources and know-how needed to be done 

When? A timeline of tasks had to be agreed upon by the different collaborators and stakeholders 

 
Even though these questions are only the starting point of a very long and iterative process, the 
goal was to obtain as much information as possible to determine what kind of challenges lay ahead.  

The first set of criteria that needs to be applied to any design project is one that enables the team 
to be aware of the many factors affecting the correct performance of a design solution. Therefore, 
any design problem has to be understood as being: situational, contingent, circumstantial, and 
deliberative. 

It is situational because each design problem is unique in that it is linked to a specific temporal 
moment. As time goes on, the problem changes, and so should the solution. A full understanding 
of the various situations in which the new design will perform will allow the solution to remain 
useful and desirable to users over time. 

                                                
12 https://www.rodzmas.com/ 
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It is contingent because the new design’s success will directly depend upon a series of external events 
that must take place for it to perform favorably. The challenge for the design team is to discover 
which events are more relevant than others and find a way to ensure that they happen. 

It is circumstantial because its success depends upon a fact or series of facts that will affect its 
performance. Therefore, a full understanding of the social, economic, technological, political, 
cultural, and environmental factors surrounding the new design is crucial for its proper 
performance.  

It is also deliberative because there is no one correct way to solve a problem, but rather many 
possible solutions that depend upon various points of view and distinct strategies. 

Once the team was able to view the project through these lenses, it was understood that the team 
had been experiencing what Weiner and Brown (2006) call “educated incapacity,” or the 
accumulation of too much specialized knowledge which clouds the vision and prevents designers 
from seeing the bigger picture. In being so focused on solving the engineering side of the project 
and on the details of constructing a VR world, the team was overlooking other crucial factors that 
would affect the performance of any solution and the efficacy of its visualization. 

The collaboration with RODZMAS led to a series of tools that helped to understand the project 
according to the four factors listed earlier in order to classify, compartmentalize, and prioritize 
information so that sub-teams could be assembled to become more efficient. With this new 
division of responsibilities, the sub-teams began to work simultaneously on interrelated problems 
and shared information. An engineering team worked on the bogie’s design and on the 
photovoltaic system that would power the vehicles and stations. The urban planning team from 
SJSU and the architecture team from SIU worked to find the optimal route for the system to follow 
and to develop a 3D model of the study area in San José.  

After these steps were accomplished, the teams were reassembled, with an architectural team 
focused on developing the stations and the guideways as well as the structures that support the 
guideways. An industrial design team focused on the user journey and the user experience of the 
system. And a transportation design team concentrated on designing both the interior and exterior 
of the pod (passenger cabin). 

All of the new teams followed a process developed by RODZMAS to deal with complex 
innovation projects like this one. The general outline of this process is illustrated in Figure 32 
below. 

The RODZMAS process is not linear, as the information derived from tests conducted in any of 
its design phases can contradict previous knowledge, and revisiting earlier phases may be required. 
The emergence of new information can happen at any stage of the process and may require 
additional research, or it might spark a new ideation phase, such that the process commonly and 
regularly jumps from one stage to another in any sequence. This process is also iterative, as several 
rounds are often required to arrive at a solid proposal.  

Once the conceptualization phase is complete, the resulting design is ready for testing, just as a 
hypothesis would be tested using the scientific method. Traditionally, at the end of the 
conceptualization stage, usability tests would be conducted with focus groups, using a physical 
prototype of the concepts which would be built for users to interact with and give feedback. 
Nowadays, a physical prototype is no longer required at this stage because a VR usability test can 
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be performed. Especially in the case of very complex systems where the construction of an actual 
prototype would require considerable time and resources to construct, VR represents a viable way 
of testing the key aspects of different concepts by placing test users within a VR version of the 
system. 

Figure 32. General design process developed by RODZMAS.  

 
The figure lists the name of each stage, the main task to be performed within it, and the final result that 
should result from each phase. 

Urban Design and Visualization Process 

Given resource and time constraints, in lieu of a VR model, the team decided that an informative 
video using still renderings and simple animations would be the best approach to explain the need 
for solar ATN and showcase the user experience based on the conceptual model.  
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Discovery Phase 

This initial phase required the RODZMAS team to evaluate two aspects of the project at the same 
time. First, the team had to determine if the design opportunity was defined correctly. And second, 
they had to evaluate whether their internal infrastructure and organization were sufficient to tackle 
such an opportunity. 

Intellection Phase 

The first task was to conduct field research by observing people and how they move about in the 
study area; therefore, a team was assembled to scout the area surrounding San José State University 
to take notes on traffic, urban infrastructure, peak hours, and public transportation. Informal 
interviews were also conducted to understand the concerns of residents. 

The team realized that there is a clear opportunity for solar ATN to connect the SJSU campuses 
and blend into San José’s urban environment, reducing heavy dependence on cars for daily 
mobility. 

The internal assessment concluded that developing a comprehensive system design was a 
prerequisite to delivering a VR model. Therefore, the RODZMAS team drew on its experience 
in designing vehicles and structures, human factors, and communication to produce the system 
design. 

It was important to go through a rigorous design phase first to clearly define how the system would 
function and how it would impact people’s lives in a positive way. Information from previous 
research was used to begin designing the three main components of the new system: the pod, 
guideways, and stations. 

Conceptualization Phase 

With a clear goal and the proper teams assembled to attain it, all of the information gathered and 
analyzed in the previous stage allowed the team to begin an ideation phase to configure the 
different elements of the system. 

Rationale for an Automated Transit Network 

The first factor that was studied through several rounds of ideation was that the system had to 
move along a grade-separated track.13 By separating the transit vehicle and placing it above grade 
on an exclusive, elevated guideway, the system eliminates the possibility of collisions with 
pedestrians and bicyclists, and thus provides inherent safety. 
The second and determining piece of information that began to shape the overall system design 
was a recurring complaint that people were tired of facing crowds in public transportation systems. 
This clearly prevented the team from proposing yet another form of collective transport. 

                                                
13 Even though grade separation has been a feature of ATN since its conception in the 1950s, the 
visualization team did not begin its ideation process with the assumption that the system would be grade 
separated. 
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On the other hand, people who currently own a car also expressed that they were unwilling to stop 
using their car, because they do not care if they get stuck in traffic as long as they are in their own 
private space.  

Both pieces of evidence indicated that people using public or private transport were asking for 
almost the same thing: a private form of public transportation. 
These two pieces of evidence confirmed what the team had already intuitively detected: for the 
system to really be appreciated by people, it had to be both as personal as possible and as grade-
separated as possible. 
Thus, the characteristics of the ATN required the following features: 

• Navigation of the system from a pick-up to a drop-off station without having to stop at 
intermediate stations along the way 

• An elevated, grade-separated guideway network to escape congestion at street level 

• The option to travel alone or in a small group of familiars 

• Ample availability of pod cars so waiting times are insignificant 

• A high number of stations so they can be easily accessible 

• The use of solar power to make the system sustainable 

All of these characteristics have something in common; for one, they all question how public 
transportation systems work, but most importantly, they all take the human factor as their core 
priority. 

The Context 

The visualization team also considered other types of cities and locations to assure that the 
proposed design would be flexible and adaptable to other urban areas. The scenarios in Table 6 
were identified after examining the characteristics of other sites previously studied and the current 
information collected about San José: 
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Table 6. Urban design contexts. 

Amount of infrastructure Mobility challenges Number of people 

HIGH DENSITY 
DEVELOPMENT 

Major projects already 
developed, presents more 

constraints 
Other mobility solutions 
are already implemented  

 Mobility collapses due 
to saturation and traffic 

is a daily event. 
 Traffic gridlock is a daily 

event 

High 

MID AND LOW 
DENSITY 

DEVELOPMENT 

Usually at grade,roadway 
infrastructure is typical of 
a suburban neighborhood 

Issues due to traffic as 
the area becomes more 
populated or popular to 
visit or in specific time 

periods or events 

Mid to high 

NOT YET 
DEVELOPED 

None. Still in the 
planning stage 

None yet, but new 
neighborhoods can be 
planned according to 

forecasts. 

Not yet defined 

The relevance of this classification is that any research team wanting to implement a system similar 
to the one proposed in this study must identify their own context in order to optimize resources. 
In a high-density development scenario, building space will most likely be very constrained and 
difficult to come by, in addition to large numbers of people needing transportation. This will 
require specific negotiations with local authorities to find a way to adapt the system to the urban 
infrastructure already in place. The Not Yet Developed scenario requires a completely different 
process and management technique to design the transportation infrastructure from scratch. 

Therefore, solar ATN can be implemented under three different scenarios (Table 7): 

Table 7. Implementation scenarios. 
Other vehicles Existing infrastructure Required capacity 

COEXIST system shares space system adapts to 
infrastructure 

moves only part of the 
population 

REPLACE 
system eliminates the 

need for them 
system adapts to 

infrastructure 
moves the entire 

population 

CO-CREATE 
system makes them 

redundant from start 
infrastructure 

 adapts to system 
moves the entire 

population 

For example, in San José, a Replace scenario would require vast changes within the city and would 
significantly disrupt operations during the paradigm change.  

Another factor that needed to be considered in the evaluation of the complexity of this project was 
the time scale for implementing an ATN system, which varies depending on local development 
characteristics and density, which influences how to adapt to existing infrastructure. The three 
options are: 
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• Near future: immediately applicable 

• Mid-future: needs an incremental approach, with the capacity of the system growing over 
time 

• Far-future: requires proof of the concept’s effectiveness in other cities in order to expand 
the venture and become widely established 

This study was carried out under the assumption that it would be implemented within a proposed 
time frame between the near and mid future. To better understand all the specific factors that 
would intervene in the design and implementation of the system in a particular context, a matrix 
with the different situations and circumstances was used to clearly identify the specific scenario 
applicable to this study (Table 8). 

The specific scenario (mid-density and development, in the near future) dictated that the current 
infrastructure needed to be respected, meaning the ATN had to be compatible with the current 
built environment. This also meant that the already established grid of streets would most 
definitely determine the space the system would be able to occupy. 
 

Table 8. Scenario matrix. 

 Near future 
Immediately applicable 

Mid future 
Needs an incremental 
approach, with capability 
of growing over time.  

Far future 
Requires a longer 
amount of time and 
proof of concept in other 
cities 

High density and 
development 

 Coexist 
Because people that 
navigate these areas still 
need personal vehicles, a 
full replacement is not 
feasible yet. 

Replace 
If the traffic levels are 
already collapsing the 
urban fabric, it is credible 
to think cities would 
undergo drastic measures 
like complete 
replacement. 

Mid density and  
development 

Coexist 
Because people that 
navigate these areas still 
need personal vehicles, a 
full replacement is not 
feasible yet.  

Replace 
 As the evidence of the 
system is tested in other 
city areas new 
developments are more 
aggressive. 

 

Not yet developed Co-create 
These areas are a blank 
slate and can be the first 
ones to apply the system 
as infrastructure for other 
transportation solutions 
has not been developed. 
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The Pod 

The “pod” is the actual vehicle that moves people and goods through the system. The information 
obtained through the intellection phase dictated that this vehicle had to be designed with several 
special considerations in mind in order for it to be useful, usable, and desirable. 

Cagan and Vogel (2002) assert that no one will use a well-made product that they do not want. 
Therefore, even though the engineering for solar ATN has made significant progress, it was vital 
to pay attention to what people had to say during the informal interviews. 
Taking into consideration the fact that people were looking for public forms of transportation that 
could be used individually or with familiars, a discussion was held to figure out the size and rider 
capacity of each pod. Other information from the pandemic scenario also came into play regarding 
pod configuration, which made evident the incapacity of current transportation systems to respond 
to such an emergency—yet another argument against collective vehicles. These two arguments 
combined began to trace a clear path towards the design of a more compact and individualized 
vehicle capable of isolating people in its interior. 

Another important aspect that was brought into consideration by the engineering team was the 
fact that the maximum speed of the pods on the guideway was low enough that aerodynamic 
considerations for the outer shape of the pod could be downplayed, as they would not play a crucial 
functioning role in the performance of the vehicle. This naturally gave the vehicle design team 
more latitude to explore different shapes that had nothing to do with the traditional bullet shape 
that most rapid transit vehicles tend to have, especially trains and monorails.  

As shown in Figure 33, the design exploration first considered pod shapes that could accommodate 
four individuals. These early versions evolved into a more ample design (Figure 34) that was 
divided into two sections separating two groups of four people for a total ridership capacity of eight 
people. The eight-passenger version is the most recent version, as demonstrated in the video. 
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Figure 33. Early pod design ideation.  

 
Many design models and the associated human factors were explored. The assemblies above the cabin comprise the “bogie”. 
The bogie performs three major tasks: attaching the cabin to the guideway; propelling the vehicle along the guideway; and 
enabling the vehicle to navigate the passive guideway branches. 

Figure 34. Current interior layout of pod.  

 
The pod has two passenger compartments that could seat up to eight people. 

Figure 35 below shows that the outer appearance of the pod bears little resemblance to current 
forms of public transportation, as the combination of factors considered allowed for the exploration 
of new shapes and contours to give it a sleek and modern look without affecting performance. This 
does not mean that this will be the final configuration of the pod—far from it. It is only a first 
concept that needs to undergo usability and performance tests to verify the intuition of the 
designers. 
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Figure 35. Exterior rendering of the pod. 

 
 

The Guideway 

The first constraint that the design team recognized in examining the map of San José and other 
cities was the need to both keep the guideway on existing rights-of-way and avoid crossing 
privately owned property. Other elements that needed to be  considered are detailed below. 

• Trees: mostly below lamp posts 

• Lamp posts: second-to-tallest element on the street 

• Low telephone and power lines and posts: run across and along the street 

• High telephone and power lines and posts: tallest objects on the streets except for a few 
trees 

• Lanes: circulation, parking, and bike lanes 

• Medians: vary in width and usually have lamp posts and trees of lower height, although 
this varies 

• Sidewalks 

• Buildings 

• Vehicles: personal vehicles, ride-share services, taxis, public transportation (bus), bicycles, 
motorcycles, scooters, cargo vehicles 

• Food stands 

• Pedestrian bridges 

• Highway overpasses 

• Billboards 
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Once a potential guideway route to connect the SJSU North campus with the South campus was 
identified, it became evident that the greatest challenge would be how to cross Highway I-280, 
one of San José's defining urban elements. After several iterations, it was concluded that the best 
way to cross it would be to go under one of the overpasses; understandably, this bold approach will 
require future validation to confirm its feasibility. Figure 36 shows the basic idea for how the 
guideway would go underneath a highway overpass. 

Figure 36. Guideway passing beneath a highway overpass. 

 
 

Another important characteristic of the guideway that became critical for the overall operation was 
the placement of the guideway offramps and onramps where stations are located. These guideway 
sections form sidings where vehicles stop to let passengers get on or off while other pods that are 
not stopping continue along the main guideway to their destinations.14 Figure 37 shows an offline 
branch and main guideway superimposed on a Google aerial view in downtown San José. 

  

                                                
14 It is important to note that the concept of ATN is built upon having a passive guideway (no moving 
parts), and all movable switching elements are contained in the vehicle’s bogie. This is in contrast to 
typical rail vehicles (light and heavy rail, subways, and monorails), where branch switching occurs by 
moving the guiding rail. 
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Figure 37. Guideway branch to offline station. 

 
Another important consideration was the design and unobtrusive placement of the columns to 
support the guideways and solar canopies. These columns had to be as standardized as possible to 
be prefabricated in factories, then mobilized and assembled on site. They would also have to be 
capable of supporting the weight and dynamic loads of the entire system in operation while also 
being slim to make the system as unobstructive as possible. Figure 38 shows cross-sections of dual-
direction and single-direction guideways with solar canopies. 

 

Figure 38. Column and solar canopy design exploration with dual-direction and single-direction 
guideways. 

 
The canopy consisting of solar panels is another essential element (see Figure 39). These large 
arrays cover the guideways and the stations. The inclination, size, and position of the panels were 
determined by an engineering analysis of the solar energy system (see Section 2.4).  

The electricity generated by the canopies is conducted to the stations (see next section below) 
where the power can be directed immediately to the pods or stored for later use.  
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Figure 39. Solar canopies covering the guideway and station.  

 
 

The Stations 

The use of an elevated guideway creates the problem of how passengers will board pods. There 
were two possible solutions: make the pod come down to ground level or make the user go up to 
the level of the elevated guideway. Both solutions had their pros and cons, but it was the matter of 
space that favored having elevated boarding platforms instead of having the pod come down to 
ground level. For a pod to come down to ground level, the guideway would need a relatively long 
gradual slope to make a comfortable descent. But if there is a lack of space, a steeper slope would 
be required, resulting in a more abrupt descent. 

Unless a compelling reason arises, the stations will be at the same elevation as the guideway; 
however, they will not all be identical. Several factors influence the shape, size, and ways to access 
the station, both for the pods and the users. 

For example, a station could be placed on one side of the road, such as shown in the aerial view of 
the north station in Figure 40 below. Further, vehicles can come into the station in a single 
direction, and with a U-turn guideway, loops can service bi-directional movement. 
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Figure 40. Placement of the station at the North campus.  

 
U-turns on the guideway allow the single direction station to service pods travelling in two directions. 

On the other hand, Figure 41 shows a situation where two nearby car parking lots provide space 
for two stations, each servicing a single-direction guideway. 

A different alternative for the same location would be to locate a single station to serve both single-
direction guideways as shown in Figure 42, somewhat like the arrangement shown in Figure 40 
above. A set of roundabouts and U-turns are used to allow pods traveling north or south to access 
the station from either direction, while entering and exiting the station in a single direction. 
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Figure 41. Placement of two stations servicing one-way guideways between  
the North and South campuses.  

 
In this example, two proximate stations are used to serve single-direction guideways. 

 
Figure 42. Placement of a single station servicing one-way guideways between  

the North and South campuses.  

 
Use of additional guideway loops allows a single station to serve two single-direction guideways. 

The South campus station near the Spartan stadium had the largest open area of the three, and it 
allowed the team to design it with a station serving guideways on both sides so that passengers can 
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take a pod to go directly in either direction (Figure 43). This was especially important considering 
potentially large influxes of people during sporting events. East Alma Avenue pictured here is wide 
enough to accommodate guideways on both sides of the street for two-way pod movement. 

Figure 43. Placement of the station at the South campus. 

 
 

With differences in size, shape, capacity and location taken into consideration, each station was 
designed around the same type of modular construction elements to lower construction costs and 
time.  

Figure 44 below shows a section view of the most compact station (the mid-station) and illustrates 
its basic elements. This conceptual design is yet to incorporate technical specifications, as it is a 
design concept covering the list of attributes that were compiled once the intellection phase was 
completed. The design conveys a lightweight structure made up of slim columns that hold the 
overhead platform, with its solar canopy held by a truss above radial structures emerging from each 
column. These basic elements can be seen applied to the design of all stations. 
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Figure 44. Cross section of the third station midway between the North and South campuses. 

 
 

Preparation of the Video 

As mentioned earlier, in lieu of constructing a VR world to show what the ATN would look like 
and to allow stakeholders to dynamically interact with it, the team decided that it would be better 
to construct a video that would also include background information and context, plus a description 
of a typical user’s journey. The overall tone and character of the video were to be direct and 
informative, and also had to excite and move viewers to see that even the most visionary aspects of 
the proposal are quite attainable. In other words, the video would convey to viewers that the 
proposal for a solar-powered ATN is a reasonable and compelling solution for the many problems 
inherent in current mobility systems around the world.  

To create compelling illustrations to communicate these special attributes of the ATN proposal in 
an emotive way, an artist team was assembled. Representative of many illustrations produced 
specifically for the video by the artist team, Figure 45 below shows an everyday scene where the 
spaces and services have been devised to turn stations from simple boarding platforms into places 
for socialization which will foster community, equity, and livability. 
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Figure 45. North station and its use for last-mile service and socialization. 

 
 

While all of the teams were working in parallel on the design of the elements just described, a 
screenwriter was simultaneously writing the script for the video. The script was divided into five 
sections: 

1. Introduction. Describes the motivation for the project 

2. Process. Describes how the project would be carried out 

3. System. Describes the primary attributes of the system  

4. User journey. Describes how a person would use the system 

5. Conclusions. Summarizes what was accomplished and invites people to collaborate in the 
future work required to fully implement the system 

Introduction. The Introduction explains the deteriorating state of the dominant global mobility 
paradigm. Serious problems with urban mobility are illustrated and a call is made for urgent 
changes to be made with respect to how people move around in cities. Attention is drawn to the 
importance of meeting the challenge to design and implement a bold new mobility paradigm. 

Process. This section explains the importance of conducting an intellection phase prior to any design 
work in order to understand the complexity and scope of the problem. The plan to use SJSU and 
its mobility problems as a testing scenario to verify the viability of the proposal is elucidated.  

System. After the plan to connect the North and South SJSU campuses is explained, the parts of 
the system being designed are highlighted: the pod, the bogie, the guideways, and the stations.  
User journey. The step-by-step user journey is explained in an initial effort to map every single 
situation in which the user will interact with the system.  

Conclusions. The video ends by reaffirming the importance of this effort and by inviting viewers to 
collaborate with the Spartan Superway. 
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3.5 Conclusions (Visualization Project) 

The design process and work product described in this section have shown a new way forward to 
truly sustainable (carbon-free, collision-free) urban transportation. It has also been shown that the 
associated infrastructure can be integrated into an urban setting with flexibility, adaptability, and 
minimal disruption to the urban fabric. 

This report has described a mobility system that is robust and responsive to the many challenges 
identified in the Introduction of the report. Now the Spartan Superway team must gain support 
in order for concrete action to be taken. The visualization is meant to inspire stakeholders to 
engage in the development of a full-scale working prototype to test the sufficiency of solar energy 
and the functionality of the structural, mechanical, and electronic subsystems.  

The video will be used as an invitation to the local community to engage in the next steps of the 
project by giving feedback to ensure that the design process includes all critical community 
members. 
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4. Summary & Conclusions  
This section summarizes the research work and offers recommendations for future work for both 
areas: energy and visualization. 

Energy Project Conclusions: 

The Energy Project comprised the modeling, parameterization, and optimization of the grid-tied 
PV-battery energy system for the proposed solar-powered ATN. The performance of the system 
was largely dependent on the energy demand of the ATN, which was simulated with SUMO and 
SUMOPy using ridership data from the SJSU Park & Ride. The resulting energy system had a 
PV rated output of 6.2 MW, a battery system capacity of 9.8 MWh, and an estimated cost of $11.4 
million USD. The analysis examined the feasibility of the optimized energy system from four 
standpoints: physical size, performance, cost, and emissions. The energy system had a PV canopy 
width of 7 meters and a battery system volume of 15.2 cubic meters per station, which are 
sufficiently small for suitable integration into the existing urban fabric of downtown San José. The 
system maintained adequate performance by only sourcing 14% of the annual ATN energy demand 
from the grid. Additionally, it exported more energy to the grid than it imported for ridership 
uncertainties of up to 15%. The cost of the energy system was comparable with that of the existing 
SJSU Park & Ride service, and it was more economical to power the ATN with the optimized 
energy system than with electricity purchased from the grid. Finally, the solar-powered ATN was 
the only system in the study to yield net reductions in CO2 and PM2.5 emissions. Therefore, it is 
not only feasible to maintain 24/7 ATN operation with the proposed energy system, but it is also 
economically and environmentally advantageous. 

Energy Project Recommendations: 

The following recommendations were inspired by the results of the Energy Project: 

1. Solar-powered transit is strongly recommended as an effective means of decarbonizing and 
depolluting the transportation sector, based on the substantial reductions in CO2 and PM2.5 
emissions observed in the comparisons with grid-powered electric transit and diesel-bus 
transit. 

2. It is recommended that SJSU replace the current Park & Ride service with a solar-powered 
ATN.  The associated emissions reductions are projected to be 98%, at a system cost that 
is estimated to be comparable to that of the currently slow and inefficient shuttle. The 
SUMO/SUMOPy simulation results indicated that the proposed ATN will have a higher 
throughput than the existing service, with shorter trip and wait times for patrons. 

3. It is recommended that the PV canopy of the solar-powered transit system be sized to 
accommodate the maximum projected ridership over the anticipated 30-year life of the 
energy system. This is because the additional energy demand associated with increased 
ridership can only be accommodated by installing additional PV modules, which cannot be 
done conveniently after the system has been constructed. An alternative is to incorporate 
hardware provisions in the design of the racking structure that will facilitate the installation 
of additional modules after the system has been constructed. 
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4. Encourage and incentivize the development of solar-powered transit systems through 
policy that streamlines the regulatory environment. 

Energy Project Future Work: 

There are five avenues for future work associated with the Energy Project: 

1. Improve the fidelity of the energy system model by using voltage and current as the 
independent variables rather than energy. This would allow higher-resolution models to be 
implemented for dynamic components like inverters and batteries. 

2. Expand the OD matrices beyond the North and South campuses of SJSU to incorporate 
ridership between the other regions of San José that the proposed route serves. 

3. Develop optimization-based control algorithms to improve the performance of the energy 
system and minimize the amount of energy imported from the grid. 

4. Increase the fidelity of the economic analysis and quantify the operating costs associated 
with the ATN vehicles, infrastructure, and labor. This would improve the cost comparison 
between the proposed solar-powered ATN and the SJSU Park & Ride. 

5. Critique the energy system model with industry professionals to improve the fidelity and 
physical realizability.  

Visualization Project Conclusions: 

The Visualization Project examined and tested different approaches to visualizing the placement 
of the ATN in its socio-spatial context of urban San Jose. Different visualizations and visualization 
tools were used. For example, ArcGIS was used as a visualization tool to explore different route 
alternatives, SketchUp was used to model massing and scale and to visualize the relationship of 
the ATN network to the street, and Autodesk software was used to provide detailed renderings of 
the station and the interior of the cab. 

The researchers found that although the field of visualization technology has matured dramatically 
over the past decade and the cost of software/training has been greatly reduced, there is no single 
piece of software that can address every aspect of a dynamic visualization project as ambitious as 
was attempted in this study. The research team discovered that the challenges of integrating 
different tools was a barrier to developing visualizations that were simultaneously realistic and 
appealing (to the general public) while providing accurate engineering specifications that are 
necessary for communication with the city’s engineering staff. In other words, the visualizations 
need to be purpose-built with a specific audience in mind.  

Ramasubramanian (2010) argues that if the goal is to use visualization to engage the public directly 
in decision-making, it is important to define and understand a public involvement process before 
planning how visualization technologies or tools will be used. Certain tools may be more suitable 
for direct public engagement, while others might be better suited to enhancing intra-organizational 
collaboration and communication. Some software applications are used exclusively for creating 
visual representations and manipulating images, while the more comprehensive tools are designed 
to facilitate collaborative decision-making processes, gather and sort feedback, or interface with 
other programs to enhance interactivity and create dynamic presentations. A visualization 
technique may be used by an agency to gather reactions and opinions from a community or to serve 
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as a medium through which the public can analyze, discuss, refine, or propose alternatives. Once 
consensus is reached for a particular proposal, an agency can use visualization tools to build that 
image to show to the public. The agency will decide whether a process can be conducted entirely 
online or whether it can support face-to-face involvement as well. Lastly, visualization can facilitate 
communication with groups typically underrepresented in public participation for transportation 
planning. This includes individuals with limited English proficiency, spatial literacy (the ability to 
read maps), and certain physical impairments. The choice and application of tools should be 
aligned with the desired output and public involvement goals of the organization. 

In terms of future research, it is proposed that a study of how to integrate 3D and 4D visualizations 
as part of planning processes include a survey of end users, be they planners/decision-makers 
working for different government agencies or representatives of community groups. Experience 
gained from this research demonstrated that starting with a clear awareness of end-users’ needs 
would help streamline the choice of visualizations.  

The COVID-19 pandemic had specific consequences that impacted the scope and approach of 
the research. It inhibited opportunities for field-based data collection, including conversations with 
stakeholders to gather information about end-user needs as originally intended. Subsequently, it 
also limited opportunities for the research team to present and engage in purposeful dialogues 
(Ramasubramanian and Albrecht 2018) in order to better shape the research outcomes. In the 
absence of such inputs and feedback, the research team modified their initial approach and 
developed an approach to tell a story, supported by visual renderings and a comprehensive video. 

Visualization Project Future Work: 

The results from this project show a credible design for a unique transportation mode that has 
tremendous potential to mitigate the many problems of current transportation modes. What is 
needed now is to get feedback on the proposed concept from local stakeholders, including potential 
users, property owners, developers, and city leaders. This could take the form of face-to-face 
surveys, online surveys, neighborhood association meetings, or other public forums. It would also 
help to get additional feedback from other communities, especially those who have expressed some 
interest in ATN; for example, Milpitas, Mountain View, Austin TX, Atlanta GA, Greenville, SC, 
Cape Town in South Africa, Maputo in Mozambique, Lagos in Nigeria, Kigali in Rwanda, and 
many cities in India and China, to name just a few.  

With feedback from stakeholders, additional iterations of the visualizations will be needed, and 
ultimately from these, professional architectural and technical designs will be realized on the path 
to implementation. 

Overall Conclusions and Recommendations 

Our world faces an existential threat with the current climate crisis. Existing modes of motorized 
transportation are the largest contributors to GHGs, and therefore, must be the focus for making 
disruptive changes that will actually work towards solving this urgent problem. This study reports 
on a unique and impactful approach to urban transportation that, if implemented by SJSU, would 
not only eliminate the GHGs generated by the SJSU Park & Ride shuttle, but could also attain 
the goal of carbon neutrality for mobility and even assist neighboring electricity consumers with 
the system’s surplus of clean energy.  
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This study has demonstrated a conceptual design workflow that produced a viable route to connect 
the North and South campuses of SJSU despite the major challenge of traversing the I-280 
Highway. The team also produced a video, which in conjunction with artistic presentations and 
engineering prototypes, provides a platform to gather stakeholder feedback to guide further 
development.  

In light of recent work on its overall campus Master Plan, it is recommended that SJSU take these 
actions: 

• Encourage multiple academic departments within SJSU and across CSU to collaborate and 
speed the development of solar ATN 

• Facilitate IRB approval to conduct stakeholder surveys to get feedback on the conceptual 
design of the system linking the North and South campuses 

• Obtain funding from external sources to further academic research and implementation of 
solar ATN for intercampus transportation 

• Publicize the innovation in solar ATN that has been going on for the last nine years at 
SJSU (Spartan Superway) 

Once the results of this study are understood by the SJSU community and its leaders, SJSU has 
the potential to lead the world in fighting climate change and improving the safety and quality of 
urban life. Many of the great innovations in solar energy were created in Silicon Valley. It is only 
fitting that San Jose State, the #1 most transformative university15, would lead the global 
transformation to solar transportation. 

  

                                                
15 From a ranking by Money Magazine as reported on the SJSU website: https://www.sjsu.edu/ 
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Appendix A: SUMOPy Modeling Procedure 
This appendix outlines the process of developing a micro traffic simulation using SUMOPy for 
the area impacted by a proposed ATN that would connect the North-South SJSU campus areas. 

Scenario Creation 

• Create a new scenario via Scenario > Create > New…

• Fill out the dialog window, noting that the Shortname must not contain any whitespace or
special characters

• Click Apply, then Run

• Save the scenario (CTRL+S)

Network Creation 

Download OpenStreetMap (OSM) XML Data (Method #1: OSM Website) 

● Go to https://www.openstreetmap.org/ and pan/zoom the map to the region of interest

o Click Export and then Manually Select a Different Area

Figure A1. Exporting an OpenStreetMap map - Method #1. 

● Adjust the bounding box to enclose the desired area (urban region surrounding the PRT
network) and click Overpass API (see Figure A2)

o Note: Clicking Export instead of Overpass API will also work if the region is small
(< 50,000 nodes).

● Move the downloaded OSM XML file to the scenario working directory

● If any problems are encountered, use Method #2 instead



 

 80 

Figure A2. Adjusting the bounding box in OpenStreetMap map export. 

 
 
Download OpenStreetMaps (OSM) XML Data (Method #2: OSM Web Wizard) 

● Open the OSM Web Wizard by navigating to C:\Program Files (x86)\Eclipse\Sumo\tools 
and double-clicking osmWebWizard.py 

● In the Position tab, search the city that the PRT network will be located in, and pan/zoom 
to the region of interest 

● Click, Select Area, and adjust the bounding box to enclose the desired area 

Figure A3. Exporting an OpenStreetMap map - Method #2. 

 
● In the vehicles tab , uncheck all options (this minimizes the file size) 

● Click Generate Scenario (this processes and downloads the map data) 

● The scenario data will be saved to a created folder titled yyyy-mm-dd-hh-mm-ss. This will 
most likely be in the Sumo directory for the user who is currently logged into the PC (e.g., 
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C:\Users\jack\Sumo\2020-07-09-23-41-08). If not, it will be in C:\Program Files 
(x86)\Eclipse\Sumo\tools. 

Import OSM Network 

● Import the OSM data into SUMOPy via Network > Import > From osm.xml… 
● Configure the import settings: 

○ OSM File Name: In the Osm Files field, select the OSM XML file to import, 
depending on the download method that was used: 
■ If Method #1 was used, open the OSM XML file that was downloaded and 

saved in the working directory (the file type may have to be set to All files if 
it is not initially present in the browser window) 

 
■ If Method #2 was used, open osm_bbox.osm.xml from the associated yyyy-

mm-dd-hh-mm-ss folder 
○ Pedestrian Footpaths: If the OSM region has a poor representation of pedestrian 

footpaths/sidewalks, these must be generated by SUMO during the network import 
to allow pedestrians to freely walk to PRT stations. This can be done by checking 
the Guess Sidewalks box, which causes SUMO to add pedestrian footpaths alongside 
each road edge in the network. 
■ Note 1: From the authors’ experience, San Jose is well-represented in OSM 

and has not yet required automatic generation of footpaths. 
■ Note 2: Relying on the footpaths from the OSM data (i.e., not generating 

them with SUMO) is problematic if they are poorly modeled. Specifically, 
if footpath edges are not connected at junctions, pedestrians have no way to 
walk between edges. The quality of the footpath representation can be 
assessed in NETEDIT (see the Create the PRT Network section below) by 
using the Move tool to slightly adjust (or “wiggle”) suspect junctions. If all 
surrounding edges move in concert, the junction is properly configured. If 
any edges are not attached to the junction, the connection can be made by 
simply dragging the edge endpoint to the junction with the Move tool. Of 
course, it is not feasible to manually check every junction in the imported 
network, but special attention should be paid to junctions in close proximity 
to stations. SUMO will also generate a warning message if it detects an edge 
that terminates in close proximity to a junction. Finally, missing footpaths 
can be created according to the methods presented in the Create the PRT 
Network section. 

■ Note 3: If unsure of the quality of the OSM footpath representation, 
generating footpaths automatically in SUMO will guarantee that 
pedestrians will be able to walk throughout the network. However, this may 
be redundant (e.g., OSM footpaths and SUMO-generated footpaths may 
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exist alongside each other), giving the network a cluttered appearance, but 
it will not negatively impact the simulation. 

○ Join Nodes: Ensure the Join Nodes box is checked, which automatically connects all 
edge endpoints that are within the specified Node Join Distance. An acceptable Node 
Join Distance is 20-30 meters (too low a value will be ineffective; too high a value 
will cause unwanted nodes to be joined). 

○ Traffic Signal Cycle Time: The Cycle Time parameter defines the duration of one 
traffic signal cycle and is applied to all intersections. Despite the PRT network 
operating independently of traffic signals, pedestrians must adhere to traffic signals 
when crossing intersections. Thus, the Cycle Time has a direct impact on pedestrian 
travel time to PRT stations. The average cycle time for the region should be used 
if it is known. Otherwise, a conservative value of 120 seconds may be applied. 
■ Note: It is possible to edit the Cycle Time parameter for each junction after 

the network has been imported. 
○ Default Parameters: Prof. Schweizer used the following import parameters for his 

test network in San Jose, which serve as a good set of default values. 
 

Figure A4. Default parameter values for OpenStreetMap map import 

 
● Click Apply, then Run (this may take some time; click the Zoom to Fit icon  on the 

display window when finished). Figure A5 is an example of a successful import:  
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Figure A5. Successful import of an OpenStreetMap map. 

 
● Import the building footprints via Landuse > Facilities > Import from osm… 
● In the Osm Files field, select the same OSM XML file that was just imported. The other 

parameters can be left as their default values. 
● Click Apply, then Run (the building footprints should appear in the display window). 

Figure A6 is an example of a successful import:  
Figure A6. Successful import of building footprints from OSM file. 

 
● If an error occurs, there was likely an unacceptable character in the XML file (typically an 

ampersand “&” in the name of a building). This can be remedied by opening the XML file 
in a text editor and replacing all problematic characters with a space " ". 

● Save the scenario 
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Download Satellite Image Underlay 

● To download the satellite image underlay, select Landuse > Maps > Download…
● Select the Tile Width from the drop-down menu (select a width and click Apply to 

populate the Number of Tiles field; try to get the number of tiles down to ~50 or less, 
though the maximum allowable value is 300)

● Enter a Google Maps API key
● Click Apply, then Run (images will be downloaded one-by-one; progress can be viewed in 

the console output)
● Save the scenario (this saves the downloaded satellite images in the working directory to 

eliminate the need to make future Google Maps API calls for this scenario) 

Create the PRT Network 

● The NETEDIT tool is used to prepare the network for simulation. Documentation is
listed here: https://sumo.dlr.de/docs/netedit.html. Open NETEDIT via Network > Edit
with sumo netedit on map… (the “on map” suffix indicates that the satellite image underlay
will be included). Figure A7 is an example of the unedited network:

Figure A7. Unedited PRT (ATN) network and satellite imagery (from Google Maps). 

● Select Processing > Compute Junctions (F5) to render the junctions. This can be done
whenever changes are made to nodes and junctions to improve visualization.

● Make the PRT network easier to see by displaying it in a different color. This is done by

clicking the color wheel  and selecting the Streets tab in the dialog box. Then set the
Color field to by permission code. The PRT network should be associated with permission
code 2.74022E+07 and the color can be changed by double-clicking it. If this permission
code is not present, an edge of the PRT network must first be created (see below).
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Figure A8. Changing the color of streets in SUMOPy. 

 
● Create stations: 

○ The basic architecture of a station is a two-lane segment of guideway with one lane 
designated for PRT vehicles and the other for foot traffic and bikes. A bus stop 
“additional” is placed on the PRT side of the station, which allows pedestrians to 
board and alight the vehicles. The length of the station edge should allow “buffer” 
regions before and after the bus stop, each approximately half the length of the bus 
stop. Finally, acceleration/deceleration ramps should connect the PRT side of the 
station edge to the guideway, while footpaths connect the pedestrian side to the 
surrounding footpaths. 

○ Create a new segment of guideway for the station with the Create Edges tool  
i. Click to place the first endpoint (junction) of the edge, then click in another 

location to place the second endpoint (junction). 
ii. NOTE: The order of the endpoints defines the direction of travel (i.e., PRT 

vehicles will travel from the endpoint that was placed first, to the endpoint 
that was placed second). A little arrow that shows the travel direction will 
often be generated on each edge, which serves as a quick check. 

○ Select the created segment of guideway with the Inspect tool  
○ Set the number of lanes (numLanes) to 2 
○ Set the spread type (spreadType) to “center” to center the edge between the 

endpoints 
○ Deselect the Select Edges box at the top of the window, which allows individual 

lanes to be selected 

 
○ Set the lane parameters: 

iii. NOTE: It is critical that the pedestrian lane is on the right side of the PRT 
lane (from the perspective of being in the podcar traveling through the 
station). This is because bus stop additionals (the component that allows 
pedestrians to board and alight the podcars) can only be placed on the right 
side of the PRT lane. An example is shown below.  
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Figure A9. Locating the pedestrian lane during creation of a PRT (ATN) station.  

 
It is critical that the pedestrian lane be located on the right side of the PRT lane (from the perspective of 
being in the podcar traveling through the station). 

iv. Select the lane designated for the PRT guideway and set: 
● Speed: 3 m/s 
● Allow: Custom1 
● Width: 2 m 

v. Select the lane designated for pedestrians and set: 
● Speed: 0.8 m/s 
● Allow: Pedestrian, Bicycle 
● Width: 2 m 

○ Press F5 to render the network 

○ Select the Additionals tool by clicking the  icon and set: 
vi. Additional Elements: busStop 
vii. Name: type a descriptive name 
viii. Length: 30 m (can be modified at the designer’s discretion, but this is a 

reasonable value if unsure) 
○ Click on the PRT lane of the station edge to place the bus stop. If it does not 

appear, there may not be enough room at that location--try clicking nearer to the 
endpoints.  

ix. NOTE: Again, the bus stop additional can only be placed on the right 
side of the PRT guideway. Refer to the above image under the “Set the 
lane parameters:” bullet for an example. 
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○ Use the Move tool  to adjust the location of the bus stop so that it is 
approximately in the center of the station edge. Also, adjust the endpoints of the 
station edge so that an appropriate buffer exists before and after the bus stop (a 
general rule of thumb for buffer lengths is half of the bus stop length). Press F5 
when finished to render. 

○ Create the “on-line” segment of the guideway (this is the segment that will parallel 
the station): 

x. Use the Create Edges tool  to create the guideway edge (remember that 
the direction of the guideway is dictated by the order that the endpoints are 
placed) 

xi. Select the Inspect tool by clicking the  icon 
xii. Click the edge that was just created to select it 
xiii. Configure the edge internal attributes: 

● Speed: Maximum allowable speed on the edge in m/s (i.e., line 
speed) 

● NumLanes: Number of lanes on the edge (should be set to one for 
a one-way PRT guideway) 

● Allow: Select custom1 in the associated dialog box as the only 
allowed vehicle (this represents the PRT vehicle class). See Figure 
A10. 

Figure A10. Configuring the edge internal attributes. 

 
● SpreadType: Set spreadType to center if edge is one-directional or 

to right if bi-directional traffic flow (this is only for visualization--it 
centers the edge between the endpoints) 

● Width: Lane width in meters (a value of 2 m is reasonable for PRT 
guideways) 

○ Add the acceleration and deceleration ramps by connecting the station edge 
endpoints to the nearby endpoints (junctions) of the “on-line” segment of 
guideway. (If it is necessary to create junctions on the guideway, right-click the 
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desired location on the guideway and select Edge Operations > Split Edge Here. 
Junction/endpoint locations can also be adjusted by dragging them with the Move 

tool .) Use the Create Edges tool  to create the acceleration and deceleration 
ramps in a similar fashion to that outlined under the “Create the ‘on-line’ segment 
of the guideway” bullet. 

xiv. Tip: Use the Inspect tool  to select the “on-line” segment of guideway, 
and in the Templates section, click Set edge ‘ABC’ as Template to store these 
internal attributes. All subsequently created edges will default to these 
attributes. 
● NOTE: It is critical that the speed attribute for each deceleration 

ramp is set lower than the guideway line speed. Otherwise, the 
vehicle management algorithm seems to have issues (i.e., vehicles 
have abnormal behavior like stopping at every station or getting 
stuck in stations). A deceleration ramp speed of 2 m/s worked well 
(with a station speed of 3 m/s and line speed of 10 m/s). 

xv. Note: It is important to model the acceleration and deceleration ramps with 
realistic lengths for proper physical and visual representation. The following 
plot should be used as a guide (Burford Furman, 2019). Accordingly, a ramp 
length of at least 35 m is required to maintain comfortable accelerations for 
a line speed of 10 m/s 
 

Figure A11. Stopping distance for ATN vehicles vs. maximum line speed. 
  

 
The shaded region represents reasonable deceleration levels for PRT/ATN vehicles and their corresponding 
stopping distances for offline stations. The dashed curve represents stopping distances for a deceleration level 
that is considered to be a maximum for emergency braking conditions for railway vehicles (and passengers 
without seat belts). (Figure from Furman, 2019). 
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○ Add footpath ramps in the same way, connecting the endpoints of the station edge 
to nearby footpaths. Be sure to copy and use the edge template for the nearby 
footpath, or alternatively, create a new edge and set the Allow field to Pedestrian 
and Bicycle. 

○ Repeat this process for all remaining stations. By the end, you should have all 
stations placed and their lanes properly configured. Pedestrian lanes should be 
connected to nearby footpaths, and acceleration/deceleration ramps should connect 
each station to a parallel segment of “on-line” guideway. 

i. This process can be made more efficient by selecting the Inspect tool , 
selecting the Select Edges box 

, and 
selecting an edge. In the Templates section, click Set edge ‘ABC’ as 
Template to store these internal attributes. All subsequently created edges 
will default to these attributes, so they do not have to be created from 
scratch.  

● Create the guideway: 
○ Once the stations and their parallel “on-line” guideway segments have been created, 

all that remains is to connect the “on-line” segments together with the other 
segments of the guideway. 

ii. NOTE: It is bad practice to use junctions to connect straight sections of 
guideway (doing so may cause simulation errors down the road) because this 
creates an overwhelming number of route edges. The best way is to create a 
single guideway edge that connects one station to another. This will be a 
straight segment when it is initially created, so it must be adjusted with 
geometry points to conform to the desired route. 

○ Create a guideway edge: 
iii. Option 1: Follow the procedure listed under the “Create the ‘on-line’ 

segment of the guideway” bullet (sub-bullet of the “Create stations” bullet). 

iv. Option 2 (preferred): Use the Inspect tool  to select the “on-line” 
segment of guideway and in the Templates section, click Set edge ‘ABC’ as 
Template to store these internal attributes. All subsequently created edges 
will default to these attributes. 

v. Whichever option is used, place the first edge endpoint on the outlet 
junction of one station (where the “on-line” guideway segment and station 
acceleration ramp merge) and the second edge endpoint on the inlet 
junction of the next station (where the station deceleration ramp splits off 
of the “on-line” guideway segment). 

○ Edit the edge: 
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vi. Select the Move tool  and click anywhere on the edge and drag to create 
a geometry point (depicted as a red dot). Drag this geometry point to 
conform the edge to the desired route. Repeat with as many geometry points 
as needed. The following figure distinguishes geometry points from 
junctions.  
 

Figure A12. Editing an edge in SUMOPy. 

 
 

● Note: Attempt to make radii of curves fairly smooth and 
dynamically realistic, as curvature energy losses are computed in the 
energy model. A good rule of thumb is to attempt to maintain a 
maximum comfortable acceleration of 2.5 m/s2 at line speed. Thus 
rmin = (vline)2 / (2.5 m/s2). No need to place hundreds of geometry 
points, 3-5 is usually sufficient for most curves. 

○ It is likely that edges and junctions will need to be created to bridge different 
segments of station-to-station guideway (to create a network of guideways instead 
of a big loop). Consider the following tips: 

vii. If it is necessary to create junctions on a guideway edge, right-click the 
desired location on the guideway and select Edge Operations > Split Edge 
Here. 

viii. Junction locations can be adjusted by dragging them with the Move tool 
. 

ix. Remember that the direction of the guideway is dictated by the order that 
the endpoints are placed. 

x. Junctions can be combined by dragging one junction into another. 
○ Design Tip: When creating the guideway, it is recommended to make bi-

directional connections to create “sub-loops” within the “outer loop.” Doing so 
gives the PRT vehicles more direct paths to their destination stations, improving 
network performance. Economically, these connections are best placed in locations 
where their lengths are shortest. The following image illustrates examples of these 
connections, circled in red. 
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Figure A13. Bi-directional connections in SUMOPy 

 
• Set edge endpoints: 

o Set the endpoints of the station edge, acceleration ramp edge, deceleration ramp 
edge, pedestrian entrance edge, and pedestrian exit edge by selecting the Move tool 

 and shift+left-clicking near each junction of each edge (can alternatively right-
click the desired location on each edge and select Edge Operations > Set Geometry 
Endpoint Here). The set endpoints are represented by red circles and can be moved 
by dragging with the move tool . These define the shape of each junction and 
“lock” the position of the junction, preventing it from being recomputed in a 
different location when rendered. Thus, the set endpoints should be placed near 
each junction, as exemplified in the following image (the red dots on the pink PRT 
guideway are in close proximity to the grey junctions). When finished, press F5 to 
render. 

Figure A14. Setting edge points in SUMOPy. 

 
● Configure junctions: 

○ A typical station will involve four junctions: 
xi. Split off main line to deceleration ramp 
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xii. Intersection of deceleration ramp with station edge (also connects 
pedestrian path with pedestrian side of station) 

xiii. Intersection of station edge with acceleration ramp (also connects 
pedestrian path with pedestrian side of station) 

xiv. Merge from acceleration ramp onto main line 
 

Figure A15. Configuring junctions in SUMOPy. 

’ 

○ Select each junction with the Inspect tool  and set the following (all other 
defaults are OK): 

xv. Type: Zipper (behavioral classification of junction) 
xvi. Radius: 1.5 (turning radius in meters) 
xvii. keepClear: Checked 

○ Repeat this for all junctions on the network 
xviii. NOTE: This is very important—it allows the vehicle management 

algorithm to navigate vehicles throughout the network. 
○ Select Processing > Compute Junctions (F5) to render the junctions 

● Check connections: 

○ With the Inspect tool  selected, check Show Connections in the upper toolbar 
 

○ Scroll around and inspect the connections throughout the network to ensure they 
are correct (i.e., a pedestrian path should join with the pedestrian side of the station, 
PRT deceleration/acceleration ramps should connect with the PRT side of the 
station). An example of correct connections is shown below: 
 

Figure A16. Checking connections in SUMOPy. 

 
○ If any connections are incorrect, repair them by selecting the Edit Connections tool 

 
xix. Select the Source lane of the connection (upstream lane) by left-clicking it so 

that it is highlighted in blue 
xx. Select the Target lane of the connection (downstream lane) by left-clicking it 

so that it is highlighted in green 
xxi. Click the OK button to save the connection 
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xxii. Repeat for the remaining incorrect connections 
● Save the network via File > Save Network… 

● Save the stations via File > Additionals and shapes > Save Additionals 

● Close NETEDIT 

● Save the scenario (this updates the object file to include the route) 

Create the Traffic Analysis Zones (TAZs) 

● Select Landuse > Zones > Clear All (this seems odd as no zones have been created yet, but 
for some reason, I could not create zones unless I did this first) 

● Select the Zone tool by clicking the  icon 

● Name the zone by completing the Zone Name field 

● Create the zone by left-clicking on the display window to place vertices. Double-left-click 
when placing the final vertex to complete the zone. A right-click will abort the zone 
drawing operation. The outline will turn green once the zone has been created. 

● Create subsequent zones by following the same procedure of typing a new name in the 
Zone Name field and drawing it on the display window. An example of a two-zone network 
is shown in Figure A17: 

Figure A17. Creating Traffic Analysis Zones (TAZs) in SUMOPy. 

 
● When finished, verify that all zones have been successfully created by navigating to 

Landuse > Zones and ensuring they are listed 

Figure A18. Checking Traffic Analysis Zones (TAZs) in SUMOPy. 

 

● Exit the Zone tool by switching to the Net Selection tool  
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● Note: Zones can be renamed by selecting them with the Net Selection tool and changing 
the Name field. Zones can be deleted with the delete tool. 

● Save the scenario 

Create the Origin-Destination (OD) Matrix 

● Select Demand > Zone-to-Zone Demand > Add Zone-to-Zone Flows… 

● In the Add OD Flow Wizard, select Edit > Add OD Flow to Table to create a new OD 
row of the matrix. Enter the values and define the Start Time and End Time (which 
correspond to the duration in seconds that the OD matrix is valid for), Mode (set to 
custom1 for PRT vehicles), and Scale (this allows the OD matrix values to be scaled by a 
constant factor. Alternatively, an OD matrix can be imported from a CSV file, via File > 
Import CSV… 

○ Note: The Activity fields can be left as their default values (e.g., home and work). 
These are only used in more complex simulations in which activities are assigned 
to travelers, enabling them to create chains of trips throughout the day (e.g., work 
→ store → home). 

● Click Apply and then Save Flows 

○ Note: If the dialog window does not close after clicking Save Flows, there is an 
error (you can verify this in the command prompt window). Try clearing all 
demands, vehicles, virtual population, and zones. Then save, close SUMOPy, open 
it, recreate your TAZs, save, and try creating the OD matrix again. 

● Repeat this process to add and configure as many OD matrices as desired (typically for 
different time periods throughout the day). 

● Save the scenario 

Configure PRT Attributes 

● Note: If this sequence has been done, but you returned to NETEDIT to modify the 
network, it is best practice to select Plugins > PRT > Clear Vehicles and repeat the 
following steps before running the simulation. 

● Select Plugins > PRT > Make Stops  

● Select Plugins > PRT > Merge Nodes 

● Note: This is a pre-simulation step for the PRT vehicle management system, facilitating 
its ability to properly manage merges. 

○ Troubleshooting: If this operation fails (or freezes SUMOPy), there is likely an 
error in the network definition. Return to NETEDIT and ensure all junctions on 
the PRT network are set to zipper, and all edges on the PRT network are set to 
allow custom1 vehicles only. Also, ensure all bus stop additionals are on the right 
(not left) side of the PRT guideway (from the perspective of looking out the front 
of the podcar when entering the station). Finally, ensure that no junctions on the 
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PRT network are connected to (i.e., merged with) any of the junctions on the 
imported network. Joerg said the operation may fail if the route is too simple (i.e., 
composed of a single loop with two stations); in this case, try increasing the 
complexity in NETEDIT. 

■ Error Log: No stations were recognized in the merge nodes. This problem 
was that the bus stop additionals were placed on the left side of the 
guideway. The problem was fixed by deleting the additionals, reconfiguring 
the station edges so that the footpaths were on the right side of the 
guideway, and inserting the bus stop additionals on the right side of the 
guideway. 

Figure A19. Checking that stations were recognized in SUMOPy. 

 
● Select Plugins > PRT > Add Vehicles…, then define the number of PRT vehicles that the 

network will contain and click Run (10 vehicles per kilometer of guideway is a good starting 
place) 

Configure Vehicle Parameters 

● The energy model requires vehicle parameters to be defined. Access these through the 
model tree via Demand > Vtypes. 

Figure A20. Configuring vehicle types in SUMOPy. 

 
● Set the lanechange model to SL2015 if it is not already selected 

Figure A21. Setting Lanechange model in SUMOPy. 
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● Define the PRT vehicle parameters for the energy model. The parameters listed in Table 
A1 and A2 were deemed reasonable: 

Table A1. PRT vehicle parameters for the energy model. 
SUMO Parameters for 
Energy Computation 

Podcar 
Value 

Units Comments 

Max Power (Pmax) 18750 W  

Mass (mveh) 1600 kg  

Front Surface Area (Aveh) 4 m2  

Air Drag Coefficient (cw) 0.5 -  

Internal Moment of Inertia 
(Jint) 

68 kg Note that units are listed in [kg-m2] in SUMOPy. This is a 
mistake, it should say [kg] (this parameter is computed as 

an equivalent mass). 

Radial Drag Coefficient 
(crad) 

0.07 -  

Rolling Resistance 
Coefficient (croll) 

0.009 -  

Constant Auxiliary Power 
(Pconst) 

3500 W  

Propulsion Efficiency 
(ηprop) 

0.85 -  

Recuperation Efficiency 
(ηrecup) 

0.3 - This is located in the PRT electrical profile, shown in the 
image below. 
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Table A2. Additional PRT vehicle parameters for the energy model.  

 
 

● Save the scenario. 

● For reference, the parameters are used as follows to compute the energy transferred from 
the vehicle’s battery (i.e., the vehicle’s energy demand). More details are available on page 
91 of https://elib.dlr.de/93885/1/Proceeding_SUMO2013_15-17May%202013_Berlin-
Adlershof.pdf. All units are SI (E in [J], v in [m/s], m in [kg], g in [m/s2], h in [m], J in 
[kg], rho in [kg/m3], A in [m2], cw in [-], s in [m], croll in [-], crad in [-], r in [m], P in 
[W], t in [s], eta in [-]). Figure A22 shows the equations used in the energy calculations. 

Create the Virtual Population 

● If a virtual population has previously been created, delete it via Demand > Virtual 
Population > Clear Population, Plans, Vehicles and Activities before continuing. 

● Select Demand > Virtual Population > Configure Population > Create from Zone-to-Zone 
Flows… 

○ The Offset Hours field represents the number of hours from midnight that the OD 
matrix interval begins at. For a simple PRT model, this does not affect the 
simulation; however, if other modes of transit are being simulated (each with their 
own OD matrix), this value is necessary to sync the demands across modes.  
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Figure A22. Equations used to compute energy transferred from the vehicle  
battery in SUMOPy. 

 

Therefore, it is best practice to use the true value if known (i.e., offset the OD 
matrix X hours to the time of day that it is supposed to represent). 

○ Click Run (the other default parameters work well) 

○ Check to ensure the number of members in the generated virtual population 
matches the sum of the OD matrix trips 

● Select Demand > Virtual Population > Plans > Generate… 

○ Set the Strategy field to PRT and use the default values for the remaining fields 

○ Click Run, and after the loading bar has reached the end (it remains on the dialog 
window), click Done 

○ This pre-simulation step computes the mobility options (i.e., plans) available to 
each traveler of the virtual population and selects the most efficient one. The 
available plans are listed in the Plan IDs column, and the selected plans are listed 
in the ID Plan column. Individual plans can be selected by clicking the ID number 
in the virtual population table. All plans can be listed by clicking the Plans link 
above the virtual population table. 

● Save the scenario 

Run the Simulation 

● First, save the scenario. 

● Select Simulation > Microscopic Simulation > Sumo Traci.... 

● Set the Gui Mode field to sumopy+map for the satellite image underlay to be present 

○ Note: Selecting Nogui provides no visualization of the simulation but often 
computes fastest. 

● Start Time and End Time: 
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○ These are defined in “seconds after 12:00 AM.” 

○ Assign these values to correlate to the time window that is associated with the OD 
matrix (e.g., peak OD matrix could be representative of 4:00 PM – 7:00 PM = 
57,600 s – 68,400 s). Ensure that an extra 15-30 minutes are available after the OD 
matrix end time to allow all travelers to alight their podcars and finish their trips, 
as simulation results are not logged for unfinished trips (these 15-30 minutes should 
be added automatically by SUMO). 

● Check the following boxes to generate results from the simulation: 

○ Output Edge Data 

○ Output Trip Data 

○ Included Unfinished Trip Data 

○ Output Electric Energy 

○ Output Summary 

○ Rerouting Enabled 

● Click Start 

● During the Simulation: 

○ Many warnings about the route representation will likely appear in the output 
dialog—Joerg said these generally are not anything to worry about and can typically 
be ignored. 

○ The delay time can be adjusted to control the frame rate of the simulation 
animation. 

○ Can right-click a person or vehicle and select Start Tracking to follow them through 
their trip. 

○ The general premise of the simulation is that the number of trips generated between 
each TAZ is read from the OD matrix. Within each TAZ, the trip origins and 
destinations are distributed among all buildings, according to the building 
footprint. Then, people are generated and assigned an origin-destination pair, in 
which they leave their origin building, walk to the nearest PRT station, ride the 
PRT to the station nearest their destination, alight, and walk the remainder of their 
trip. 

○ Once the simulation finishes, the SUMO simulation window will close. Click 
Done on the SUMO-Traci dialog box to store the results (this takes some time to 
compile the results). 

○ Save the simulation. 

Viewing Results 
• Use the menu tree to select results to view (this menu is also accessible via Simulation > 

Results > Browse). 
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o Note: In Edge Results, all edges of the route (all roads/footpaths in the OSM 
region) are listed. The new edges that were created for the PRT guideway were 
appended to the imported edge list and appear at the bottom. 

• Exporting Results 

o Click Export to csv… 

Figure A23. Exporting results in SUMOPy. 

 
• Saving Results 

o Click Simulation > Results > Save as 

Figure A24. Saving results in SUMOPy. 

•  
o For the filename, Joerg said to always type the suffix “.res.obj” 

Figure A25. File naming convention in SUMOPy. 

 
o Note: The Stop Results are not included in the saved results file. If intending to 

plot stop results (see below), do so right after the simulation. 

o Save the scenario 

• Loading Results 

o ALWAYS open the associated scenario object first 

o Click Simulation > Results > Open and select the results file 
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Figure A26. Loading results in SUMOPy. 

 
• Plotting Edge Results 

o Click Simulation > Results > Plot edge results on map 

Figure A27. Menu pick for plotting edge results in SUMOPy. 

 
o The dialog box allows all plot settings to be configured. 

o Select the Edge Quantity to plot (e.g., selecting the Entered edge quantity will plot 
each edge of the route on a color scale, with color indicating the number of vehicles 
that entered onto that edge during the simulation). 

o Click Plot (this can take some time), an example output is below: 

Figure A28. Plotting edge results in SUMOPy. 
 

 
• Plotting Power Demand 

o Click Simulation > Results > Plot electrical energy 
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o Click Plot or Plot and Close to generate a plot of power demand vs. time. An 
example output is below: 

Figure A29. Plotting power demand in SUMOPy. 

 
• Plotting Stop (Station) Results 

o Click Plugins > Prt > Results > Stopresults with matplotlib 

Figure A30. Menu pick for plotting station results in SUMOPy. 

 
○ Select the ID of the station you want to plot (“Id Stop Plot” dropdown menu) 
○ Adjust plot settings if desired 
○ Click Plot, an example output is below: 

 
Figure A31. Plotting station results in SUMOPy. 
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Appendix B: Route Planning Fieldwork,  
Area Modeling, and Station Design 

This appendix documents fieldwork to determine the best passageways under Highway 280, 
ArcGIS mapping, tradeoffs for single- and dual-direction guideways, and area modeling. The 
ArcGIS route plan map can be viewed here: https://arcg.is/LLaWq. 
B.1 Route Planning Fieldwork 

 
Figure B1. Current condition under S 2nd St. 

 
Figure B2. Current condition under S 3rd street 

 

 



 

 104 

Figure B3. The two alleys between S 1st street and S 3rd street 

 
 

Figure B4. Area with dense packing of electric cables and poles area between  
North and South campus. 
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Figure B5. Typical utility pole and wiring in the areas shown in Figure B4. 

 
 

Figure B6. Parking lots and other vacant spaces distributed between SJSU’s  
North and South campuses.  

 
Routing the guideway down 1st St. 1st St. is the only street that will allow stations to be placed every  
400 m - 500 m without significant changes to existing buildings. 

B.2 Station Site Selection 

In order to meet the goal of keeping station spacing to 400 - 500 m, site inspections were 
conducted to observe the surrounding environment. It is most desirable to place guideways along 
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the streets and consequently stations adjacent to the streets. Doing so will take advantage of 
existing rights-of-way and minimize disruptions. 

Stations should be placed adjacent to frequent destinations such as schools, grocery stores, plazas, 
etc. and close to high high-density residential property, such as apartments. 

This criteria was applied to the study area, and the sites that met the criteria were marked as blue 
bubble icons in ArcGIS, as shown in Figure B7 below. 

The area of these sites was measured, and the ArcGIS pop-up window function was used to upload 
the dimensions of these sites in the form of photos, either taken on-site or by aerial photos from 
Google. This data was imported as photos into the blue bubble icon, which is available as shared 
data. 
 

Figure B7. Potential station sites. 
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Figure B8. Keyes station. 

 
 

Figure B9. Measurement near Keyes station. 
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Figure B10. Potential route path down E Humboldt Alley. 

B.3 One-Way vs. Dual-Direction Guideway

Single-direction guideways and dual-direction guideways are different, so the size and form of 
associated stations for each type will also be different. Therefore, before entering the station 
design step, the guideway configuration must be decided (one-way or dual-direction) to ensure 
that the station can match the function required by the different off-line systems.

B.3.1 Single-Way Guideways

A single-way guideway network needs multiple path loops to minimize travel distances in the 
service area (See Figure B11). While single-way guideways simplify the elevated guideway 
structure, they have two drawbacks. First, they require a larger coverage area to achieve an 
adequate level of service. Second, with more guideway loops, more support columns are 
needed, and this significantly increases the number of column footings, which means more 
geotechnical work and higher costs. Several strategies can be employed to mitigate these 
drawbacks. The first is to increase the number of stations and podcars. This effectively increases 
the system's capacity and shortens travel time. Furthermore, for a single-way guideway, only one 
offline guideway services a station, so the station's design can use simple architecture, be 
relatively compact, and be constructed relatively quickly (See Figure B12). Finally, it is worth 
mentioning that networks constructed with single-way guideways also have the possibility to 
collect more solar energy than comparable dual-direction networks, because more guideway 
length is needed for the single-way network. 

B.3.2 Dual-Direction Guideways

Compared to single-way guideways, an ATN network with dual-direction guideways has less 
guideway length for similar service. A network with dual-direction guideways is also simpler for a 
user to understand the route map. However, dual-direction guideways do not fit in all rights-of-
way (for example, passing underneath Hwy 280), so some amount of single-way guideways will 
be needed in any network. 
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Less length of guideway also reduces costs, the number of support columns for the network, and 
less disruption during construction. 

Figure B11. Single-direction guideway configuration for the study area. 

Figure B12. Single-direction guideway and station. 

The lower costs and advantages of the dual-direction guideways influenced the determination of 
the north-south campus route to mostly be composed of dual-direction guideways with single-
direction guideways only where needed (Figure B13). 
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Figure B13. Proposed guideway network utilizing mostly dual-direction guideways. 

B.4 Alternate Passageway Underneath Hwy 280 

An alternate passageway underneath Hwy 280 via Senter Rd in the south was identified. It uses 
the bicycle lane under Highway 280 and then connects to E San Salvador St. to the North campus 
(see Figure B14). This configuration does not meet the goal of having stations spaced every 400 - 
500 m apart, so it was not investigated in the current project. This guideway path has the advantage 
of being concealed and therefore being out of view from most stakeholders, and it connects the 
North and South campuses in a very direct way. 

B.5 Creating a 3D Design “Sandbox” for the City of San José 

A 3D content model of the city of San José was created to allow the research team to import any 
virtual model they wished, as well as to facilitate the evaluation of the relationship between their 
model and the status quo of the city. A screenshot of the 3D “sandbox” is shown in Figure B15. 

 
 
  



 

 111 

Figure B14. Alternate guideway route between the North and South campuses. 

 
The team investigated photorealistic 3D data made with AI technology from the TurboSquid16 
platform and explored its use to model the guideway in a realistic-looking city environment. Figure 
B16 shows the guideway placed into the model using TurboSquid dataset. 

Figure B15. 3D “sandbox” model of the study area. 

 
 

                                                
16 https://www.turbosquid.com/  
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Figure B16. ATN guideway inserted into the sandbox 3D model with 3D  
data from TurboSquid. 
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Appendix C: InfraWorks and SketchUp Modeling Guide 
The information contained in this appendix explains the methods developed to create a base model 
to be used in a 4-D dynamic model. It covers the methods explored for developing the model 
beyond a basic mass model. Previous work by architecture students at SIUC revealed that using 
InfraWorks makes for a good base model, so this work primarily examines InfraWorks. 

C.1 Creating the Basic Infraworks Model 

The Maps, Footprints of Buildings, and basic 3D Models in INFRAWORKS come from Open 
Street Maps. The procedure to follow is: 

1. Open Infraworks > Model Builder (Figure C1) 

2. Select Area of Interest (AOI) as shown in Figure C2. 

3. Create the Model. 

4. When done, it will be on Infraworks Home Page. Open your New Model. 

Figure C1. Infraworks Home Page - Model Builder Highlighted. 

C.2 Models and adjustments within InfraWorks 

InfraWorks offers models constructed from footprints from Open Street Maps and the model-
making capabilities within the software (see Figure C3). These models offer flexibility in the 
facades but only as a set of generic possibilities. As the goal of the Visualization Project was to give 
a more realistic look to a video presentation, these models may be adequate for some buildings, 
but others will need to be defined in greater detail. Figure C4 shows examples of various façade 
styles that can be applied within InfraWorks. 
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Figure C2. Area of interest highlighted with no additions.  

 
(The focus area for the N-S campus network). 

 
Figure C3. Editing the characteristics of a building within InfraWorks. 

 

The ability to change an individual face of a model is important as it allows the application of 
unique images to the sides of the model. This applies to both in-software models and imported 
models. To allow for individual face manipulation, the model detail level needs to be raised to 
Medium. The procedure to do this is: 

Settings > Application Options > Model 

Generation> Building Facade Detail> then set it to Medium. 
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Figure C4. Examples of Various Facade Styles within InfraWorks. 

 
 

Figure C5 shows Settings and Applications highlighted. 

Figure C5. Settings and Applications highlighted. 

 
 
C.3 Importing External Models into InfraWorks 

Being able to import models from external 3D modeling software expands the possibility of using 
InfraWorks as a master model holder. InfraWorks does have internal 3D modeling editing 
capabilities, but they are limited, and with the development of architectural models for things like 
ATN stations, school buildings, and sports stadiums, it is desirable to have them appear 
realistically, which will give viewers an accurate of an idea of what the built environment will look 
like. Figure C6 shows some of the 3D models that InfraWorks accepts.  

The process for importing a 3D model is: 

1. Open the model manager 

2. Under Create and Manage Model > Data Source 
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3. In the Data Sources Menu, open the 3D model menu 

4. Select the type of Model to import. Make sure the files are the correct file type, for example 
a Sketchup File will only read a .skp file, but a 3D model will read .3ds, .dae, .dxf, .fbx., 
obj types 

5. With the model loaded, (it will be found under the no feature type file found in the Data 
Source menu), select it to bring up the data configuration menu. 

6. Configure the model type(1). 

7. Use Interactive Place to place the model into your InfraWorks model. You can adjust the 
model after you have placed it. If you know the X, Y, and Z coordinates, you can enter 
those here to place the model. 

8. Click on Close and Refresh (See Figure C8). 

Figure C7 below shows an example of a 3D model import. Figure C8 shows the Configuration 
screen for 3D model imports. 

Figure C6. 3D model types that can be imported.  

There are additional file types within these options. 
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Figure C7. 3D model import into InfraWorks. 

  
Figure C8. Completing the 3D model import into InfraWorks. 

C.4 Applying Photos to Surfaces of a Model in InfraWorks 

The process for applying photographs to surfaces of building models in InfraWorks is described 
below: 

1. Locate the photos of the building that are to be applied. This modeling guide uses images 
from Google Earth and Street views, but it is best practice to get your own photos if 
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possible. (See Section C.7 for information on best practices for photos for this purpose. 
Photos could be gathered as part of a site survey). 

2. Once pictures are accumulated, use photo-editing software to flatten out the photos, 
remove any non-essential information, and if necessary, combine or deconstruct the photo 
to fit the model. For example, the original CEFCU stadium model shown in Figure C9 
results in multiple faces to apply photos to when the model detail is adjusted to Medium 
as shown in Figure C10. To make the photos realistic, the picture needs to be broken up 
into chunks (Figure C11). Each chunk of photo will be placed on a single face. 

3. Export the image in .jpg format. 

Figure C9. CEFCU Stadium image from Google Earth. 

 
 

Figure C10. Breaking the InfraWorks stadium model into multiple faces. 
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Figure C11. Photo “chunks” to be applied to the InfraWorks building model. 

 
 

In InfraWorks, go to Material Creation by selecting Create and Manage Model > Style Palette > 
Materials. [Big red I > Cube > Green Plus sign at bottom of window >Texture > press the ... 
button> to load the image. 

1. Create a new material. Make the type a texture, and bring in your photo file. 

2. Adjust the width and height of material to the size of the face you are applying it to using 
the measure function. 

Figure C12 shows the InfraWorks model of CEFCU Stadium before and after applying photos to 
the face of the building model. This method is quick but results in flat-looking buildings. The 
method would be better used for the second-level of detail models. If all you have is InfraWorks, 
this method will work. 

Figure C12. CEFCU Stadium in InfraWorks before (left) and after (right)  
photos have been applied to the side of the stadium model facing the viewer. 

 
 

C.5 Building a Model in SketchUp and Applying a Photo Texture 

This method produces a better-looking model than the basic InfraWorks model. The flexibility to 
create shapes that tilt or extend horizontally facilitates a better virtual environment. Procure as 
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much information and as many photos as necessary from on-site surveys to use for modeling as a 
reference. Procedure: 

1. Open SketchUp 

a. Before going any further, check to see if a 3D model already exists in the 3D 
Warehouse. Starting with a pre-existing model will save you time. 

2. Use Geo-Locate to bring in a photo from Open Street Maps (OSM) to use as a reference. 

a. [ File> Geo-locate > Select Region >Import] (See Figure C13) 

Figure C13. Importing a photo from OpenStreetMap  
(OSM) to use as a reference. 

 
 

3. Make adjustments for ease of modeling. For example, squaring up at least one side to an 
axis allows one to use the axis constraints in SketchUp. 

4. Construct the building. 

5. Use good SketchUp practices, i.e., grouping faces before extruding, so you can control the 
editability of a model. Break the model up into its basic component, squares-circles, etc., 
and use Google Earth for heights if needed. See Figure C14. 

Figure C14. Extruding basic shapes in SketchUp. 
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6. Grouping your model will make editing the individual pieces much easier. Make the chosen 
face editable by double-clicking it to activate the group. 

7. After you have edited your photo, in SketchUp, you will import the photo using 
File>Import>, and navigate to where you put the file. Figure C15 shows the Import dialog 
and the image to be imported. 

Figure C15. Importing a photo in SketchUp. 

 
 

There are three ways to import the photo from this menu (See Figure C15):  

1. Image 

2. Texture 

3. New Matched Photo.  

Image: places an image in SketchUp  
Texture: places a photo on a face  
New Matched Photo: n/a 

Use a .JPG format for the image. This prevents some transparency issues found with .PNG files 
during the import into the InfraWorks model. If you cannot find your picture, try changing the 
file type in the bottom right corner of the import menu. 

1. Apply it to the face of the building model and adjust as needed. See Figures C16 and C17. 

2. Proceed around the model, applying photos to all the model surfaces around the periphery. 
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Figure C16. Applying a photo-texture to a face in SketchUp. 

C.6 Other Modeling Aids

www.cadmapper.com allows a free download of a square km of cities in various file types. These 
include some 3D mass models. The 3D mass model is just an extruded white box, so editing will 
be necessary, but it can be used to quickly fill up the InfraWorks model. This approach works well 
for the earliest stages of modeling and offers a quick way to make box models upon which textures 
can be placed. 

Figure C17. Repeating a texture in SketchUp.

C.7 Recommendations for Taking Photographs of Buildings

During the research, there were legal issues using Google Earth and Street images that would be 
problematic for the commercial application of the modeling process. It is recommended, if 
possible, to shoot one’s own photos for this process. Such photographs should be taken as part of 
a street-level inventory and could also be used to create a database of conditions to examine, 
problems to solve, and assets to document along the guideway route of the ATN.  

This section is a quick primer on how to best take photos for use as a surface texture on building 
models. Photos should be taken as safely as possible. The basic idea is to get photos that encompass 
the whole building or can be utilized to create composite photos of the entire building. If the 
building has prominent features that should be modeled, then those parts should be photographed 
as best as possible. 

Some basic photography ideas: 

- Do not shoot photos into the sun, with bad glare, or with inconsistent illumination of the surface

- Take photos of the same building under consistent conditions, i.e., the same day, time, and other
conditions

Where the building can be photographed in its entirety, try to take the photos so that the camera 
is pointed perpendicular to the building’s face instead of at a glancing angle (Figure C18). The 
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same preferred orientation applies when multiple shots are needed to capture the face of the 
building, as shown in Figure C19. 

Figure C18. Preferred camera orientation for capturing a photograph of a  
building in its entirety (plan view).  

 
The camera should be pointed toward the building along a line that is perpendicular to the face of the 
building to be captured in the picture rather than a glancing angle. 

 
 

Figure C19. Preferred camera orientation for capturing a photograph of a building when 
multiple pictures are needed to capture the full face of a side (plan view).  

 
The camera should be pointed toward the building along a line that is perpendicular to the face of the 
building to be captured in the picture rather than at a glancing angle. 
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Figure C20 shows how pictures should be taken in elevation view. 

Figure C20. Preferred camera orientation for capturing a photograph  
of a building in elevation. 

 

 
Corner shots will probably require more photo editing to get a satisfying result. For example, if 
the building shown in Figure C21 is to be included in an area model, it will take less time to 
photograph using orthogonal views such as Figures C21 and C22. Figure C21 shows how two 
photos can be stitched together if the building is too large for one photo. The red line shows the 
edge used as a reference line for cutting the building into two chunks. 

 
Figure C21. A corner shot of a building.  

 
This camera orientation will make it challenging to turn the photo into an appealing photo texture to be 
applied to a building digital model. 
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Figure C22. Building photographs using orthogonal views.  

 
These orientations will make it easier to turn the photograph into appealing photo textures to be applied to a building digital model. 
The photograph on the left shows how two photos can be stitched together if the building is too large for one shot. The red dashed 
line in the photograph on the right shows the edge used as a reference line for dividing the building into two chunks. 
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Appendix D: MATLAB Script for Energy  
System Simulation  

The MATLAB script for the energy system simulation is presented as follows. 
function [P_grid,P_bat,SOC] = 
batterySim(numModulesCanopy,numBatPacks,singleModPVSupply,totalAuxPVsupply,vehDemand,auxDemand,si
ngleBatCapacity,singleBatMaxPower,reserveSOC,batteryRoundTripEfficiency,transformerEfficiency,net
PVEfficiency,netVehEfficiency) 
% Function for simulating grid and battery power supply and demand. 
%   The PV supply array, vehicle demand array, and auxiliary load array are 
%   loaded and the simulation steps through each hourly time step, 
%   computing the amount of power sourced/sunk from the grid and battery 
%   bank.  The simulation applies all PV power to the load, and then 
%   charges/discharges the battery, subject to limits on battery AC power 
%   and SOC.  The grid serves as a source/sink to fill in any remaining 
%   supply/demand.  All power values are in [W]. 
  
% Sign Conventions: 
% '+' = sink to grid / charge battery 
% '-' = source from grid / discharge battery 
  
%   Jack Fogelquist; April 2, 2021 
  
%%%%%%% Setup 
dt = 1; % [hr] simulation time step 
SOC_0 = 0.5; % [-] initial SOC for start of simulation 
SOC_max = 1; % [-] maximum SOC limit 
SOC_min = reserveSOC; % [-] minimum SOC limit 
batteryOneWayEfficiency = sqrt(batteryRoundTripEfficiency); % [-] battery one-way efficiency 
singleBatCapacity = singleBatCapacity*1000; % [Wh-DC] convert from kWh to Wh 
singleBatMaxPower = singleBatMaxPower*1000; % [W-AC] convert from kW to W 
systemBatCapacity = singleBatCapacity*numBatPacks; % [Wh-DC] capacity of entire storage system 
systemBatMaxPower = singleBatMaxPower*numBatPacks; % [Wh-AC] power limit of entire storage system 
  
%%%%%%% Check Inputs 
if (size(singleModPVSupply,1) ~= size(vehDemand,1)) || (size(singleModPVSupply,1) ~= 
size(auxDemand,1)) % if the supply and demand arrays have dissimilar lengths 
    disp("Mismatch in energy supply and demand array lengths - simulation terminated") 
    return 
end 
  
%%%%%%% Build Canopy 
canopyPVsupply = singleModPVSupply.EnergySupply*numModulesCanopy + totalAuxPVsupply; % [W] scale 
single module supply according to the number of modules across the canopy 
  
%%%%%%% Initialize 
P_grid = zeros(size(singleModPVSupply,1),1); % initialize grid power array 
P_bat = zeros(size(singleModPVSupply,1),1); % initialize battery DC power array 
SOC = zeros(size(singleModPVSupply,1),1); % initialize battery SOC array 
  
%%%%%%% Simulation 
for i = 1:size(singleModPVSupply,1) % for each hour 
    % Compute Net Supply and Demand 
    P_PVnet(i) = canopyPVsupply(i)*netPVEfficiency; % [W] net power from PV canopy with losses 
    P_loadnet(i) = vehDemand.EnergyDemand(i)/netVehEfficiency + auxDemand.EnergyDemand(i); % [W] 
net load from vehicles and auxiliary infrastructure with losses 
    % Determine SOC of Previous Time Step 
    if i == 1 % for first time step 
        SOCprev = SOC_0; % previous SOC is initial SOC 
    else 
        SOCprev = SOC(i-1); % store previous SOC 
    end 
    % Compute Battery and Grid Power 
    if (P_PVnet(i) >= P_loadnet(i)/transformerEfficiency) && (SOCprev < SOC_max) % if there is 
surplus PV power and battery can be charged 
        P_bat(i) = batteryOneWayEfficiency*(transformerEfficiency*P_PVnet(i) - P_loadnet(i)); % 
[W] DC power to battery 
        if P_bat(i)/batteryOneWayEfficiency > systemBatMaxPower % if AC power to battery exceeds 
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limit 
            P_grid(i) = P_bat(i)/batteryOneWayEfficiency - systemBatMaxPower; % [W] sink excess 
AC power to grid 
            P_bat(i) = systemBatMaxPower*batteryOneWayEfficiency; % [W] compute DC battery power 
at AC power limit 
        end 
        SOC(i) = SOCprev + P_bat(i)*dt/systemBatCapacity; % [-] update SOC 
        if SOC(i)>SOC_max % if battery exceeds maximum capacity 
            P_grid(i) = P_grid(i) + (P_bat(i)-systemBatCapacity/dt*(SOC_max-
SOCprev))/batteryOneWayEfficiency; % [W] sink excess AC power to grid 
            P_bat(i) = systemBatCapacity/dt*(SOC_max-SOCprev); % [W] compute DC battery power for 
SOC = SOC_max 
            SOC(i) = SOC_max; % [-] set SOC to maximum value 
        end 
    elseif (P_PVnet(i) >= P_loadnet(i)/transformerEfficiency) && (SOCprev == SOC_max) % if there 
is surplus PV power and battery cannot be charged 
        P_grid(i) = transformerEfficiency*P_PVnet(i) - P_loadnet(i); % [W] sink excess AC power 
to grid 
        SOC(i) = SOC_max; % [-] SOC remains at maximum value 
    elseif (P_PVnet(i) < P_loadnet(i)/transformerEfficiency) && (SOCprev > SOC_min) % if there is 
insufficient PV power and battery can be discharged 
        P_bat(i) = -(P_loadnet(i)/transformerEfficiency - P_PVnet(i))/batteryOneWayEfficiency; % 
[W] DC power from battery (with '-' sign convention) 
        if abs(batteryOneWayEfficiency*P_bat(i)) > systemBatMaxPower % if AC power from battery 
exceeds limit 
            P_grid(i) = -(abs(batteryOneWayEfficiency*P_bat(i)) - systemBatMaxPower); % [W] 
source required AC power from grid (with '-' sign convention) 
            P_bat(i) = -systemBatMaxPower/batteryOneWayEfficiency; % [W] compute DC battery power 
at AC power limit (with '-' sign convention) 
        end 
        SOC(i) = SOCprev + P_bat(i)*dt/systemBatCapacity; % [-] update SOC (P_bat is negative 
here) 
        if SOC(i)<SOC_min % if battery discharges below minimum capacity 
            P_grid(i) = P_grid(i) + batteryOneWayEfficiency*(P_bat(i)-
systemBatCapacity/dt*(SOC_min-SOCprev)); % [W] source required AC power from grid 
            P_bat(i) = systemBatCapacity/dt*(SOC_min-SOCprev); % [W] compute DC battery power for 
SOC = SOC_min 
            SOC(i) = SOC_min; % [-] set SOC to minimum value 
        end 
    elseif (P_PVnet(i) < P_loadnet(i)/transformerEfficiency) && (SOCprev == SOC_min) % if there 
is insufficient PV power and battery cannot be discharged 
        P_grid(i) = -(P_loadnet(i)/transformerEfficiency-P_PVnet(i)); % [W] source required power 
from grid (with '-' sign convention) 
        SOC(i) = SOC_min; % [-] SOC remains at minimum value 
    end 
end 
  
end 
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